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1 INTRODUCTION  

flexAnalysis 3.0 is a post-processing software for spectra acquired with the Bruker 
Time Of Flight mass spectrometers of the flex series.  The program runs under 
Windows 2000 (SP4) or XP (SP2) operating systems. Windows NT is not supported.  

Before installing flexAnalysis 3.0 for the first time, the program Microsoft .NET 
Framework 1.1 must be installed, because flexAnalysis (since the release 2.2) is 
based on features, which Microsoft .NET Framework 1.1 provides.  This program is 
also part of the Compass installation CD (Figure 1).   

 

Figure 1 Compass CD 
flexAnalysis uses standard IBM-PC and Microsoft Windows conventions to 
operate with windows, menus, dialog boxes, and the mouse. The operator is 
supposed to be familiar with the basic operation of the computer and with 
Microsoft Windows software.  Some general instructions are given here, but if 
additional assistance is necessary regarding the basic use of a computer, please 
review its accompanying documentation. 
flexAnalysis 3.0 is able to operate in combination with the Bruker Compass Security 
Pack 1.2.  This program can be installed prior to flexAnalysis or after it.        

Main features of the Bruker Compass Security Pack are a user management, 
electronic signatures and audit trailing. This is different to the user management of the 
operating system! The Bruker User Management is a tool that allows you to manage 
the access to Bruker applications and assign individual rights to users.  Depending on 
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these rights the access of a user to features of Bruker applications is more or less 
restricted.   
On saving data files, the operator can electronically sign them, if he has got this 
specific right.  Electronic signatures consist of the operator ID and his password (Figure 
15).   

Audit trails are useful to trace back the operations of a user he made in a specific 
moment.   

The Bruker Compass Security Pack and user management are described in a 
separate manual.  

 

flexAnalysis 3.0 provides the following key features: 

Multiple spectrum display for convenient spectra comparison and analysis.   • 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

Highly sophisticated algorithms for authentic automated and interactive peak 
detection (SNAP, Centroid, and Sum Peak finder). 

Highly sophisticated algorithms for spectrum processing (smoothing, baseline 
subtraction). 

Highly sophisticated algorithms for automated and interactive recalibration of 
spectra (linear, quadratic, statistical and High Precision Calibration support). 

MS/MS support: Presentation and processing of LIFT spectra as well as 
generation of FAST spectra. 

Annotation 

Spectrum and graphic export. 

Report designer for creating user defined analysis reports and specific report 
layouts. 

Integrated Sax Basic Development Environment for the design of 
flexAnalysis methods and scripts.  Sax Basic is Visual Basic for applications™ 
compatible. 

Proteineer Support: Integrated data exchange with BioTools and ProteinScape 
program packages.   

Data processed in flexAnalysis 3.0 can be delivered in form of spectra and 
peak lists to further interactive data processing software packages such as 
GenoTools (SNP (Single Nucleotide Polymorphisms), genotyping analysis). 

Polytools (monomer determination, average molecular weight). 
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1.1 Getting Started 

In case of installing flexAnalysis 3.0 as a standalone version, it can be installed from 
the Compass 1.2 installation CD (Figure 1).  

 

 

 

1.2 Installing flexAnalysis 3.0  

Please refer to the separate installation instructions on the Compass installation CD, 
or contact Bruker via e-mail (page 1-1). 

 

 

 

1.3 Removing flexAnalysis 3.0  

1. Start your Windows application. 

2. Click . 

3. Point on Settings. 

4. Click Control Panel. 

5. Double-click Add/Remove Programs. 

6. From the applications list, select Bruker Daltonics flexAnalysis 3.0. 

7. Click Add/Remove. 

8. Follow the Install Shield Wizard instructions to remove flexAnalysis 3.0 from 
your system. 
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1.4 Licensing flexAnalysis 3.0 

Before flexAnalysis starts for the first time the dialog shown in Figure 2 appears. 

 

Figure 2 FA is not yet licensed 
 

After applying the “OK” button the Bruker Daltonics LicenseManager (Figure 3) 
appears. The flexAnalysis license key comes in a separate envelope with the 
software. Enter the key in the edit field New License Key and press the “Add” button.   

 

 

Figure 3 The Bruker Daltonics License Manager. 
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If the Bruker Compass Security Pack is installed licenses can only be added or 
removed by users who have the corresponding right. In this case the dialog shown in 
Figure 4 appears to enter the password. 

 

 

Figure 4 Enter the password to add or delete a license key 
A license key can be removed with the “Delete” button.  The warning shown in Figure 5 
appears.  

 

 

Figure 5 Warning before deleting a license 
 

The Bruker Daltonics LicenseManager dialog box can also be launched from the 
Compass Menu with the License command (section 2.4.12.2).   
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1.5 Starting and Closing flexAnalysis 3.0 

 

Start: 
flexAnalysis 3.0 can be started via the Windows Start menu.  During installation of 
the Bruker Daltonics Applications package, a Bruker Daltonics folder was 
automatically created in the Start menu's Programs folder, which contains the 
applications delivered by Bruker Daltonik.  Select the flexAnalysis entry from this 
folder in order to start flexAnalysis 3.0.  A second way to launch flexAnalysis 3.0 is 

double clicking the corresponding icon    on the Windows desktop.  

 
 
 
Exit: 
This procedure closes flexAnalysis 3.0.  On closing, the current user interface settings 
are automatically stored.   

In order to exit flexAnalysis 3.0 click the application's Close button  or from the 
File menu select Exit, or press Alt + F4. 

If required, answer the appearing confirmation request in order to save the current 
processing state of a modified analysis. 
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2 GRAPHICAL USER INTERFACE (GUI) 

 

Figure 6 The Graphical User Interface. 
The GUI is composed of the following items:  

Title Bar (section 2.1). • 

• 

• 

• 

• 

• 

• 

Toolbar (section 2.2).  

Status Bar (section 2.3).  

Menu Bar (section 2.4). 

Analysis List Window (section 2.5). 

Mass Spectrum Window (section 2.6). 

Mass List Window (section 2.7). 
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2.1 Title Bar 

The Title Bar (Figure 7) contains the name of the application, and, if one analysis is 
selected, the title of the analysis file.  If a title is not set in flexAnalysis (Properties 
dialog, Figure 21) the first two comments, shown in Figure 21 are displayed in the Title 
Bar. The left end of the Title Bar contains the application's “Control-menu” button.  The 
right end contains the “Minimize”-, “Maximize”-, and “Close”- buttons just as all other 
Windows applications.  

 

 

Figure 7 Title Bar of flexAnalysis 3.0 
 

2.2 Toolbar 

 

 

Figure 8 Toolbar of flexAnalysis 
 

Feature buttons have been given for commands that are regularly used.  These buttons 
are organized into several groups and can be found also in the menus.   
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2.3 Status Bar 

The Status Bar (Figure 9) is located at the bottom of the GUI. In the middle it contains 
the sample name of the currently active spectrum for a saved spectrum 
(automsms\0_I14\) or the name of the loaded processing method (PMF (read-only)) as 
long as the spectrum is not saved.   

 

 

 

Figure 9 Examples of a Status Bar for a saved and un-saved spectrum 
 

The second field displays the parent mass in case of fragment spectra (not shown 
here).  

The third field shows the selection mode (Annotate), which is just active. The next field 
shows the name of the current user followed by two fields that show the current mouse 
pointer position in the Mass Spectrum Window.  

 

2.4 Menu Bar 

The Menu Bar (Figure 10) consists of 13 pull down menus.  These menus contain all 
the features to operate flexAnalysis.  Open a menu with the left mouse button, for 
example the File Menu as shown in the following section. 

Most of the features that are available in these menus can be found also as buttons in 
the button bar, or as entries in the context menus of the three main flexAnalysis 
windows.  

 

 

Figure 10 Content of the Menu Bar 
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2.4.1 File Menu 

 

Figure 11 Contents of the File Menu 
The File Menu is composed of commands to open, close and save data, handle the 
user management and adjust the printout. 
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2.4.1.1 Overview 

Table 1  Features of the File Menu 
Feature 
button 

File Menu 
commands 

Shortcut Description 

    

 Open Ctrl + O Opens the “Open multiple spectra” dialog. 

 Open single 
Analysis Ctrl+Shift + O Opens one selected analysis. 

 Close Ctrl + F4 Closes the selected analysis or analyses. 

 Close All   Closes all analyses. 

 Load  Loads an analysis in the treeview. 

 Unload  Unloads an analysis from the treeview 

 Save Ctrl + S Saves results of the selected analyses 
including the method. 

 Save As  
Saves results of the selected analyses 
including the method to a user specific 
location. 

 Save All Shift+Ctrl + S Saves results and method of all open 
analyses. 

 Sign Electronic 
Record  Signs an electronic record. 

 Show 
Signatures  Shows the signature of a signed file.  

 Export  Offers various possibilities to export data. 

 Print Preview  Displays print preview using the selected 
report layout. 

 Print Ctrl + P Prints a report for the selected analyses. 

 Properties Alt + Enter Displays analysis and mass spectrum 
properties (variable table). 

 Exit Alt + F4 Closes flexAnalysis. 
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2.4.1.2 Open 

The Open command opens the Spectrum Browser dialog that allows selecting and 
loading spectra depending on several filter criteria (it is not necessary to select the fid 
file to load a spectrum).  

 

Figure 12 Spectrum Browser 
Browse: Select the folder from the hard drive with the data of interest.   • 

• 
• 

• 
• 

Root: Shows the selected path and folder.   
Filter Spectra: Select checkboxes to filter the data type you want to open. A 
tree structure on the left side of Figure 12 appears, if the data structures 
correspond to the flexControl saving convention.  If the saving convention is not 
applied select the checkbox “Unknown” to let the data appear.  
From – To: Time filter to search for spectra.  
Spectrum Properties: Shows the properties of a selected spectrum.   
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• Spectra selected: Displays the number of selected spectra. Applying the 
button “Clear Selection” sets it to 0. 
Spectra: Shows the number of selected spectra in comparison to the total 
number of spectra found in the chosen root directory.   

• 

• 

• 
• 
• 
• 

Open: Loads all selected spectra in flexAnalysis and closes the Spectrum 
Browser.   
Cancel: Closes the Spectrum Browser without loading a file. 
Select All: Selects all folders and subfolders of the chosen root directory.   
Clear Selection: Undoes the “Select All” function. 
Load all selected spectra: Loads and opens the spectra in flexAnalysis.   

2.4.1.3 Open Single Analysis 

In contrast to the Open command where one or more spectra can be opened at the 
same time the Open Single Analysis command opens only one spectrum. Here 
it is necessary to browse to the fid file (in the spectrum tree) and select it. 

flexAnalysis reads spectra, which are saved in the so called XMASS-file format. In this 
file format raw data are stored in a file called “fid”.  Data already processed from 
flexAnalysis or flexControl are stored in a file called “1r”. If the analysis was not 
processed before, the raw data file fid is loaded, otherwise the result spectrum of the 
process (1r). 
Additionally to the spectrum a method is loaded automatically. A flexAnalysis method 
determines how to process an analysis. The method that is loaded together with the 
analysis is either specified by the analysis itself (due to method assignment during the 
save process in flexControl) or, if no specification has been done in flexControl or 
AutoXecute, by the Default Method selection. 

If a spectrum has never been saved with flexAnalysis before, the method script (part 
of the method) is executed.   

The drag and drop mechanism to open spectra works as follows: 

a. Start flexAnalysis. 

b. Start the Windows Explorer. 

c. Navigate for the “fid”-file of the spectrum you want to open.  

d. Drag and drop the selected “fid”-file on the display windows of flexAnalysis.  

In case of loading FAST spectra that have been acquired with flexControl 1.x, and 
therefore have no valid calibration, the dialog shown in Figure 13 appears to load the 
matching calibration file (*.psd).   
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Figure 13 Searching for FAST calibration files 

2.4.1.4 Close 

Files are closed with the Close command, the corresponding icon  of the Toolbar, 
or the short cut (Ctrl + F4). 

The feature closes only those analyses that are marked in the Analysis List Window.  
In case the analyses are currently not saved a confirmation dialog appears and asks 
for saving before closing. 

2.4.1.5 Close All  

The Close All command closes all open analyses. In case any spectrum is currently 
not saved a confirmation dialog appears and asks for saving before closing.  

2.4.1.6 Load and Unload 

The Load command loads the data of an analysis that is open but not yet loaded 
(Figure 14) in the flexAnalysis treeview from the hard drive in the memory. The 
Unload command unloads them again.  

Alternatively you can click with the mouse in the corresponding checkboxes in the 
Analysis List Window to load the analysis. 
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Figure 14 Loaded and unloaded spectra in the treeview  
If you want to open a large number of spectra in the flexAnalysis treeview without 
loading them all at once, you may open them with the Spectrum Browser (Open 
command, Figure 12). In this dialog you will find the checkbox ‘Load all selected 
spectra’ at the bottom. For loading a lot of spectra the checkbox should not be 
activated. Otherwise, if you only want to load few spectra at once, activate this box. 

2.4.1.7 Save 

The Save command, the corresponding icon  of the Toolbar, and the short cut 
(Ctrl + S) store the current processing state of the selected analysis including the 
processing method.    

The Save command can be applied to several selected analyses at a time after these 
have been marked in the treeview with the <Shift> or <Ctrl> - keys of the keyboard 
thus following Windows conventions.   

2.4.1.8 Save As 

The Save As command is used to save the selected analyses including the method 
with a new name and to a new location.  

2.4.1.9 Save All 

The Save All command or the short cut (Shift + Ctrl + S) stores the result 
spectra of all opened analyses at once, including the processing methods.  
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2.4.1.10 Sign Electronic Record 

The Sign Electronic Record command is used to sign spectra electronically 
when they have been processed. It is only available if additionally the Bruker Compass 
Security Pack is installed. After a spectrum is signed it is write protected. 

To sign a spectrum it is necessary that the user who wants to sign has the 
Usermanagement given right to sign. This is checked during the sign process when the 
user fills in his Operator name and password (Figure 15). The field Meaning may be 
used for comments.  

 

Figure 15 Sign Electronic Record dialog 

2.4.1.11 Show Signatures 

The Show Signatures command is also only available if additionally the Bruker 
Usermanagement is installed and becomes active if a signed file is marked in the 
treeview.  It opens the View Signatures dialog. 

 

Figure 16 View Signatures dialog 
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• Date: This column shows the date and your local time.  The value most right in 
this example +1:00 corresponds to GMT +/- your time zone.  
Signed by: This column contains the name of the user, who has signed the 
spectrum.   

• 

• 

• 

Meaning: This column contains the comment that has been entered during 
signing.  
Valid: This column contains remarks about the current validity status of data.  In 
this example the validity is not yet checked.  To do so apply the “Check Validity” 
button.  The attribute unknown will change to valid.  

 
A double click on a signature in the list opens a dialog that shows if the state of all 
checked files is ok.   

 

Figure 17 List of files, three file are mismatched 

2.4.1.12 Export 

The Export command is used to export spectra and graphics into other applications, 
or a peaklist to Excel. To retain versatility spectra are exported in the common ASCII-
file format, whereas graphics are exported in the common emf-format (Windows 
Enhanced Metafile).  With this macro only one Mass Spectrum can be exported. With 
the Batch Processing macro and a suitable flexAnalysis method more than one mass 
spectrum can be exported at the same time. 

On selecting the Export\Mass Spectrum command the “Export Mass Spectrum” 
dialog appears to save a 2-column tabular with pairs of data points (m/z / intensity).  
Enter a file name into the field File name and press the “Save” button.  flexAnalysis 
creates the corresponding file.   
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On selecting the Export\Graphic command the “Export Graphic” dialog appears to 
specify the file name and location to the export a graphic.  

The Export\Mass List to Excel command exports the peaklist to Excel.  An 
example is shown in Figure 18. This macro exports all available peaklist parameter. It 
is not possible to select only some of them.  

 

Figure 18 Mass List exported to Excel 

2.4.1.13 Print Preview 

The Print Preview command and the corresponding feature button  of the 
Toolbar open the dialog shown in Figure 19 for further adjustments. The printer and 
special report layouts can be chosen here. The button “Preview” at the bottom of the 
dialog opens the actual preview and displays the selected spectrum, as it would appear 
in the printout. 

Layouts can be created, designed, and modified with the Report Designer. The button 
“Report Designer” starts this application. It is described in section 2.4.10.2 and in the 
Report Designer manual on the installation CD.  
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Figure 19 Print Preview dialog box 
If own report layouts are created on the basis of pre-installed layouts, it is 
recommended to store the original layout before own modification are done and to save 
the modified file with a new name. Additionally be aware to use the default file structure 
to save report files: D:\Methods\Report Layouts\flexAnalysis 
If flexAnalysis is installed on a standalone system the path probably depends on the 
adjusted Regional Setting of the operating system. Otherwise the saved files cannot be 
located.   

2.4.1.14 Print 

The Print Command, the corresponding icon  of the Toolbar and the short cut 
(Ctrl + P) open the print dialog (Figure 20). A printout can be done from here with 
the button . 
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Figure 20 Print dialog 
 

 

 

2.4.1.15 Properties 

The Properties command, the corresponding icon  of the Toolbar, and the short 
cut (Alt + Enter) open the dialog Properties that consists of the General page, 
the Mass Spectrum page, and the Calibration page.  

All three tabs are displayed, if the operator has previously selected only one spectrum 
in the Analysis List Window. In case of multiple spectra selection only the General 
tab appears. 
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Figure 21 Contents of the General tab. 
The General tab (Figure 21) is used to display general information regarding the 
selected analysis such as file name, sample, mass spectrometer, title, and comments 
specific to the current analysis. Changes of title and comments can be performed and 
accepted by pressing “Apply”.   

 

Figure 22 Contents of the Mass Spectrum tab 
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The Mass Spectrum tab (Figure 22) is not editable. It displays groups of acquisition 
and processing parameters of the current analysis. The group arrangement and the 
distribution of the parameters have been done according to flexControl. The 
flexAnalysis parameter groups for example have the same names as the tabs in 
flexControl where the acquisition parameter can be adjusted. 

 

 

Figure 23 Contents of the Calibration tab 
The Calibration tab (Figure 23) can be used to verify the calibration constants.  
Additionally some general information about the calibration are shown: the possibly 
used Mass Control List and, in case the calibration constants have been copied from 
another spectrum, the sample name of this spectrum. 

2.4.1.16 Exit 

The Exit command and the short cut (Alt + F4) are used to close flexAnalysis.  
However before closing a dialog may open and ask you to save modified analyses.   
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2.4.2 Edit Menu 

 

Figure 24 Contents of the Edit Menu 
 
The Edit Menu contains commands to work with the appearance of spectra in the three 
main windows.   
 

2.4.2.1 Overview 

Table 2  Features of the Edit Menu 
Feature 
button 

Edit Menu 
commands 

Shortcut Description 

 Copy Ctrl + C Copies the selection (context dependent) 
and puts it on the Clipboard.  

 Paste Ctrl + V Inserts the contents of the clipboard. 

 Paste Special  Pastes methods, method parameters or 
method scripts. 

 Delete Del Deletes the selected mass spectrum. 
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Feature Edit Menu Shortcut Description 
button commands 

 Select All Ctrl + A Selects all open analyses including all 
mass spectra. 

 Select None Ctrl + D Deselects all currently selected analyses, 
and/or mass spectra. 

 View Analysis Ctrl + Ins Hides/Shows the selected analysis. 

 View Spectrum Ins Hides/Shows the selected spectrum 
(except raw data). 

 Set Color  Opens a palette of colors for manual 
allocation of a color to a spectrum. 

 Default Color  Resets previous color assignments. 

 Set Selection Range  Selects a mass range in the Mass 
Spectrum Window. 

 Clear Selection  Clears the current mass range selection 
in the active data window. 

 Box Selection  
Toggles Mass Spectrum Window between 
Range Selection and Box Selection 
modes. 

 

2.4.2.2 Copy 

The Copy command, the corresponding icon  of the Toolbar, and the short cut 
(Ctrl + C) are used to copy context dependent data into the clipboard. Afterwards 
the copied information may be pasted to other spectra or other applications, like 
Microsoft Office programs.  According to the active flexAnalysis window the user can 
use Copy in the 

Analysis List Window (treeview), to copy the method (parameter and script) 
from the selected spectrum. 

• 

• 

• 

Mass Spectrum Window, to copy the currently shown graphic, independent of 
the spectrum that is possibly selected in the treeview. 
Mass List Window, to copy the currently marked line(s) of the peaklist.  
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2.4.2.3 Paste 

The Paste command, the corresponding icon  of the Toolbar, and the short cut 
(Ctrl + V) are only available for the Analysis List Window (treeview). With this 
button the just copied method (parameter and script) can be pasted to one or more 
other analyses. This feature is helpful if you have adjusted and saved a new method 
and want to apply it to several other spectra.  

2.4.2.4 Paste Special 

The Paste Special command is also only available for the Analysis List View 
and applies the method, which has been copied before. Since a method consists of 
parameters and a script the operator may want to transfer only parameters or only the 
script to other analyses. In this case the Paste Special command has to be used. 

To test this feature, load three spectra in flexAnalysis. For the first one change some 
spectrum parameter (section 2.4.7.6) and edit the script (section 2.4.7.7). Mark the first 
spectrum in the treeview and choose Copy. Now mark the other spectra (<ctrl> key) 
and select Paste or Paste Special to paste the method content. Check the new 
settings for the two spectra in the parameter and the script editor.  

 

Figure 25 Paste Special dialog 

2.4.2.5 Delete 

The Delete command, the corresponding icon  of the Toolbar, and the short cut 
(Del) are context dependent. 

flexAnalysis 3.0 User Manual, Version 3.0  2-19 



Graphical User Interface (GUI) Bruker Daltonik GmbH 

In the Treeview it is used to delete one or more processing steps (corresponds to the 
Undo All Processing command) but it does not delete the raw data file (no 
feature exists in the flex programs that can delete the raw data). 

In the Mass List Window the Delete command is used to delete the selected lines 
of the peaklist. 

The command is not available for the Mass Spectrum Window. 

2.4.2.6 Select All 

The Select All command and the short cut (Ctrl + A) are used to select the 
entire content of the active window, which is the Analysis List, the Mass Spectrum, or 
the Mass List.   

2.4.2.7 Select None 

The Select None command and the short cut (Ctrl + D) refer to the active 
window and deselect everything that was previously selected.   

2.4.2.8 View Analysis 

The View Analysis command, the short cut (Ctrl + Ins), and disabling the 
root checkbox in the treeview are used to display or remove one or more selected 
analyses from the Mass Spectrum Display.   
 

 

Figure 26 Example for an analysis not displayed in the Mass Spectrum 
Window 

The analysis, which is not displayed in the Spectrum Window remains in the Analysis 
List Window, however the corresponding root checkbox is cleared (Figure 26).   

2.4.2.9 View Spectrum 

The View Spectrum command and the short cut (Ins) are used to display or hide a 
selected spectrum or selected spectra in the Mass Spectrum Window.  
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Pressing the <Ins> key a second time or selecting the related checkbox restores the 
display. A spectrum is only displayed in the Mass Spectrum Window, if both 
checkboxes (for spectrum and dedicated analysis) are selected.   

 

Figure 27 Tree view of a disabled (not displayed) spectrum 

2.4.2.10 Set Color   

The Set Color command opens a palette of colors (Figure 28).   

 

Figure 28 Palette of provided colors 
This command is used to change the color of one or more selected mass spectra.  If 
only one spectrum is selected a white frame indicates the current color used for the 
selected mass spectrum.  To change the color, simply click the desired color box. 

2.4.2.11 Default Color 

In flexAnalysis color assignments are performed according to a color hierarchy.  Each 
color in this hierarchy has a unique value.  Colors with higher values will be used prior 
to colors with lower values.  The Default Color command assigns colors to the 
selected spectra, which are currently unused and have the highest scores in the color 
hierarchy.   

2.4.2.12 Set Selection Range 

The Set Selection Range command is used to select a mass range of the 
currently active spectrum within the Mass Spectrum Window, for example to run a 
peak picking process in this specific range. Additionally, an intensity range can be 
defined, when the button “Range/box selection type” is pressed.  

In the dialog box minimal and maximal mass and intensity values can be entered to 
define the ranges. If only the mass range is requested, choose “Range selection”, to 
disable the intensity range. 
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Figure 29 Range Selection Dialog box 

2.4.2.13 Clear Selection 

This command is used to clear a selected range in the Mass Spectrum Window.   

2.4.2.14 Box Selection 

This function determines the selection mode.  If the box selection is switched on, both 
the mass range and the intensity range are selected.  If the box is switched off only the 
mass range is selected.   

 

 

2.4.3 Mass List Menu 

 

Figure 30 Contents of the Mass List Menu 
 

The Mass List Menu (Figure 30) is composed of commands to work with mass lists.   
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2.4.3.1 Overview 

Table 3  Features of the Mass List Menu 
Feature 
button 

Mass List 
Menu 
commands 

Shortcut Description 

    

 Find F5 Automatically creates a mass list for the 
selected spectrum (spectra). 

 Edit  (De)Activates the Edit Mass List mode to edit 
the mass list of the selected spectrum.   

 Edit Direct Ctrl + Alt Adds a (m/z-intensity)-pair to the peaklist. 

 Clear Shift + 
F5 Clears the mass list of the selected spectrum. 

 MS/MS List…  
Opens a list with masses that have been 
selected from the MS peaklist for manual or 
automatic LIFT measurement in flexControl. 

 Edit Mass 
Control List…  Opens the Mass Control List Editor 

 
Identify 
Background 
Peaks… 

 Identifies background peaks on the basis of a 
Mass Control List that has to be selected here. 

 
Remove 
Background 
Peaks 

 Removes the previously identified background 
peaks from the peaklist. 

 Distances in 
Mass List(s)  Macro to compare spectra. 

2.4.3.2 Find 

The Find command, the corresponding icon  of the Toolbar, and the short cut 
(F5) are used to automatically generate a peak list for one or more selected spectra 
simultaneously.   

Peak picking is performed according to the parameter settings of the current method 
(section 2.4.7.6.1). The result is stored in the peak list and the mass spectrum is 
displayed with the detected mass peak labels.   
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Only one peak list can be displayed at a time. However, more than one list can be 
(re)calculated at once, by selecting the corresponding spectra with the mouse pointer 
in the Analysis List Window and simultaneously pressed <Ctrl> key of the key board.  
Then activate the Find command for a peak finding in all the selected spectra.   

2.4.3.3 Edit 

It might become necessary to edit the peak list manually, because too many or too few 
peaks were detected during the automatic peak find procedure.   

The Edit command and the corresponding icon  of the Toolbar are used for 
interactively adding or removing peaks, according to the respective peak detection 
algorithm. 

This command displays the Edit Mass List pointers  or , if the mouse pointer is 

positioned in the Mass Spectrum Window.  The Add pointer  is displayed when 
the mouse is placed near to a peak that currently has no annotation, whereas the 

delete pointer  is placed next to an already detected peak in the spectrum. 

If the new peak can be found using the Mass List Edit Method Parameter settings, the 
results are added to the peak list and a label appears in the display. To remove a peak 
from the peak list place the Delete pointer to the peak and press the left mouse button.  

The Edit mode becomes also active when the mouse is inside the Mass Spectrum 
Window and the <Ctrl>-key is simultaneously pressed. 

2.4.3.4 Edit Direct 

The Edit Direct command, the corresponding button  and the short cut (Ctrl + 
Alt) are used to add an annotation manually. This pair of (m/z / intensity) data can be 
located at any position in the spectrum; the x-position is independent of a data point! 

If this mode is activated, the mouse in the display will get a crosshair, to better see the 
mass and intensity values. Additionally you will get a tooltip, which shows these 
information and the spectrum name as it is shown in Figure 31. This feature will be 
deactivated right after you have added an annotation manually. 
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Figure 31 Edit Mass List directly 
A peak is added to the peaklist, but only the columns for Mass, Intensity and Relative 
Intensity are filled, because the peak annotation has not been created with a peak 
detection algorithm that would calculate the other parameter.  

2.4.3.5 Clear 

The Clear command, the corresponding button  of the Toolbar, and the short cut 
(Shift + F5) are used to clear the current mass list of the selected spectrum or 
spectra.  

Select the spectrum/spectra in the Analysis List Window (if necessary with 
simultaneously pressed <Ctrl> key) whose mass list(s) shall be cleared, click , or 
from the Mass List menu select Clear. 

2.4.3.6 MS/MS List 

The MS/MS List command works in connection with the Add to MS/MS List 
command that is available in the Mass List context menu (section 2.8). Masses from an 
MS peaklist that have been added to the MS/MS List can be sent to flexControl for 
manual ( ), or automatic ( ) LIFT measurement 
(certainly also “Run method on current” can be used in flexControl).  
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To add masses from the peaklist to the MS/MS list, right-click on the desired mass and 
choose Add Mass to MS/MS List. This can be done for several peaks from the 
same spectrum and for several spectra from the same target. 

After masses have been added to the list, it can be opened with the MS/MS List 
command that is shown in Figure 32. Peak masses and spot numbers are listed. The 
whole list can be cleared with the  button; single masses can be removed with 
the button. 

The button  is used to send the whole list to flexControl. It is not 
necessary to have flexControl opened before. In flexControl (LIFT tab) the masses of 
this list are then shown as selection list, so there is no need to type in the masses 
manually one by one. 

 

Figure 32 MS/MS List with masses selected for LIFT measurement 

With the button  the chosen masses can be added to the 
AutoXecute sequence that was loaded in flexControl (AutoXecute tab) during manual 
or automatic MS data acquisition. If no sequence was loaded during the data 
acquisition the button  is disabled. 

With this feature it is possible to do automatic LIFT measurement with masses that 
have been measured and selected manually (in the AutoXecute sequence no MS 
measurement has to be specified). 

The AutoXecute method and the flexAnalysis method, necessary for automatic 
MS/MS acquisition and post processing, are added automatically to the sequence due 
to settings performed in the flexConfigurator. For more information on the method 
assignment please have a look in the flexControl user manual. 
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It is possible to add peaks from different spectra to the list. And, as seen in Figure 32, 
these spectra may have been acquired on different sample spots. The only restriction 
is that they must have been acquired on the same target! Otherwise the message 
shown in Figure 33 appears during spectra selection. 

 

Figure 33 Information concerning different targets   

2.4.3.7 Edit Mass Control List… 

For detailed information on the Mass Control List Editor, refer to the 
Quickstart_MassControlLists_Compass1.2.doc. 

2.4.3.8 Identify Background Peaks 

The Identify Background Peaks command is used to identify background 
peaks in a spectrum on the basis of a Mass Control Lists (*.mcl) that has to be 
selected with this command. 

To create or modify an existing background list, it has to be opened with the Mass 
Control List editor (section 2.4.3.7). Only masses that are marked as backgrounds in 
this list (Figure 34) can be used to identify background masses in a spectrum. Masses 
can be marked as calibrants and/or as backgrounds. The Tolerance value is valid for 
both. 

 

Figure 34 Example of a background mass list 
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After a Background list has been applied to a spectrum, all peaks are marked with true 
or false in the column Bk.Peak that can be selected as additionally shown column in 
the peaklist.  

An example is shown in Figure 35. The column Bk.Peak has been added to the Mass 
List Layout (Mass List Layout tab in the Method Editor (section 2.4.7.6.4). 
Peaks, which are identified as background in the spectrum, become colored in the 
spectrum display, according to the chosen Background Peak Label color (section 
2.4.10.11). This filter feature might be useful for further processing, e.g. database 
searches in BioTools. 

 

Figure 35 Assignment of background peaks (true) in the column Bk.Peak 
If, during an automatic run the background peak detection has been activated in the 
AutoXecute method, the information which MassControlList is used is transferred to 
flexAnalysis. The name of the Background list is shown in the spectrum Properties 
dialog (Figure 36). 

 

Figure 36 Background list information in the spectrum Properties 
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2.4.3.9 Remove Background Peaks 

The macro Remove Background Peaks is used to remove previously identified 
background peaks from the mass list and out of the display of the currently active 
spectrum. To save the new peak list save the analysis! It is not possible, to remove 
background peaks without having identified them before! 

To remove background masses automatically during an AutoXecute run, a special 
flexAnalysis method is necessary. Please contact the MALDI Software Support to get 
more information about this. 
 

2.4.3.10 Distance in Mass List(s) 

The macro Distance in Mass List(s) is used to search for specified fixed 
distances between peaks of one spectrum or of two spectra. It may be used for 
instance to search for salt adducts in MS spectra, amino acids in MS/MS spectra, or 
compare two ISD-spectra (Ion Source Decay) of the same sample but with different 
matrices in order to inspect differences in m/z of the fragment series.   

The spectrum or the spectra to be inspected have to be selected in the Analysis List 
Window.  At most two spectra can be selected. In case of more selected spectra the 
macro will be disabled!  

If not yet available, a peak list from any of the two selected spectra has to be created.  
Otherwise the message shown in Figure 37 appears.  

  

Figure 37 No peak list available 
The Distance in Mass List(s) macro opens the dialog shown in Figure 38.   
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Figure 38 AutoDistance dialog 
Distance: Mass distance value to be searched for. • 

• 
• 

• 
• 
• 

Tolerance: The search tolerance.  It can be specified in Da or ppm. 
Spectrum/First Spectrum: The drop down list contains up to two spectra.  In 
case of two define the one that is used at first. 
Calculate: Starts to calculate and search for the selected distance.   
Result: List containing the calculations of flexAnalysis.  
Save As: This button opens the dialog to save the result as a CSV-file that 
different applications, e.g., Excel can easily import.  An example is shown in 
Figure 39.   
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Figure 39 Example of a Distance-in-mass-list result 
 

 

 

 

2.4.4 Process Menu 

 

Figure 40 Content of the Process Menu 
 
The Process Menu (Figure 40) is composed of various commands to process spectra. 
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2.4.4.1 Overview 

Table 4  Features of the Process Menu  
Feature 
button 

Process Menu 
commands 

Shortcut Description 

    

 
Smooth Mass 
Spectrum  Smooth selected spectra. 

 
Subtract Mass 
Spectrum Baseline  Subtract baseline from selected spectra. 

 Undo All Processing  Reverses all processing. 

 Batch Process  Processes data in batch mode. 

 Process spectra  Easy way of reprocessing spectra. 

2.4.4.2 Smooth Mass Spectrum 

The Smooth Mass Spectrum command and the corresponding icon  of the 
toolbar are used to smooth the selected mass spectrum. The method parameter 
settings of the analysis are used for the smoothing operations (section 2.4.7.6.1).   

2.4.4.3 Subtract Mass Spectrum Baseline 

The Subtract Mass Spectrum Baseline command and the corresponding 

icon  of the Toolbar are used to perform a baseline subtraction for the selected 
spectrum or spectra.  The method parameter settings of the analysis are used for the 
baseline subtraction operation (section 2.4.7.6.1). 

2.4.4.4 Undo All Processing 

The Undo All Processing command is used to return to the starting point before 
any processing took place.  The raw data file (‘fid’-file) is loaded and displayed in the 
Mass Spectrum Window. Note that Undo All Processing does not cancel the 
possibly done calibration. If you want to apply additionally the original calibration 
constants use the command Apply raw calibration (section 2.4.5.5). 
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2.4.4.5 Batch Process 

The Batch Process macro is used to (re-)process spectra.  This command opens 
the dialog shown in Figure 41.  

 

Figure 41 Example of a Batch Process Dialog 
Folder: Select data file(s) for (re)processing with the Open Multiple 
Spectra dialog. The selected data path will be shown on top. The complete 
path(s) are displayed in the list. If spectra are loaded with the Folder button, 
you have to select a method with one of the Browse buttons below and start 
the batch processing afterwards. 

• 

• 

• 

AutoX Run: Alternatively open an AutoXecute run to load the data that have 
been acquired with this run. If flexAnalysis methods are assigned via the 
RunEditor these methods will be taken for batch processing (it is shown with the 
information “from AutoXecute” that appears after loading the run). It is possible 
to change the methods selection in the run even if the data are already 
measured and have been processed. If calibration and sample spots have been 
acquired with the sequence (e.g. on an Anchor chip target), it is possible to redo 
the post processing in flexAnalysis in exactly the required order.  

Browse: Each “Browse” button opens a dialog to select a method for the 
respective spectrum type. This method will be used for the batch process.  
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• Start Batch Process: Starts a batch process (Figure 42). The current spectrum 
in progress will be shown in the appearing window. The process for one 
spectrum can be stopped with the “Cancel” button. 

 

 

Figure 42 Batch process in progress 

2.4.4.6 Process Spectra 

The macro Process Spectra offers a simple method to (re)process MS-spectra 
without the necessity of writing a script.  The dialog shown in Figure 43 contains the 
most important processing features. They are the same as the corresponding in the 
different menus of flexAnalysis.   

 

Figure 43 Most important processing commands 
Calibrate (MS Spectrum): refer to section 2.4.5.   • 

• 
• 
• 
• 

Copy Calibration (MS Spectrum): refer to section 2.4.5.3.   
Replace Calibration (MS Spectrum): refer to section 2.4.5.4.   
Find Peaks: refer to section 2.4.3.2.   
Send Spectra to ProteinScape: refer to section 2.4.10.6.   
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Select one or more analyses in the treeview, activate the check boxes of one or more 
processings and click the “Start” button to starts the processing. A message appears 
reflecting the current state of the process. 
The parameters that are used for processing can be set in the parameter editor for 
each analysis, respectively. 
Note: Before using the Send Spectra to ProteinScape command you must 
have installed the access to your ProteinScape Server!  How to do this is described in 
the Bruker ProteinScape User Manual.   

2.4.5 Calibrate Menu 

 

Figure 44 Contents of the Calibrate Menu 
The Calibrate Menu (Figure 44) is composed of various commands that have an effect 
on the calibration of MS spectra. 

2.4.5.1 Overview 

Table 5  Features of the Calibrate Menu  
Feature 
button 

Calibration Menu 
commands 

Short-
cut 

Description 

    

 Internal  Opens the Calibration dialog. 

 Copy Calibration  Copies the calibration of a selected analysis 
into the calibration buffer of flexAnalysis. 

 Replace Calibration  
Replaces the calibration of one or more 
analyses with the content of the calibration 
buffer. 

 Apply Raw 
Calibration  Changes the calibration constants to the 

ones that came with the raw data. 

flexAnalysis 3.0 User Manual, Version 3.0  2-35 



Graphical User Interface (GUI) Bruker Daltonik GmbH 

 

2.4.5.2 Internal 

If you want to adjust calibration parameter for a new calibration of a mass spectrum of 
a selected analysis use the Internal command, or the corresponding icon  of the 
toolbar.  The Internal Mass Spectrum Calibration dialog (Figure 45) opens. During 
the calibration particular masses of the selected mass spectrum are assigned to 
corresponding reference masses of the loaded calibration list.  

Calibration is only possible for MS or LIFT spectra that have been created with 
flexControl 3.0. Old LIFT spectra and FAST spectra cannot be recalibrated in 
flexAnalysis because the MS/MS calibration is part of the acquisition system and thus 
part of the acquisition method in flexControl.   
flexAnalysis offers three calibration strategies: 

Interactive Calibration, automatic or manual, using calibration lists (MCLs). • 

• 

• 

Smart, that is an easy-to-use calibration procedure for optimum results. The 
program reappraises the statistical frequency of occurrence of calibrants.  

Statistical calibration for peptide spectra.  

The calibration strategy is saved in the flexAnalysis method and spectrum method, 
but can also be changed. 

 

Figure 45 Mass Spectrum Calibration dialog – Calibration Strategy 
“Interactive” 
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Interactive Calibration: 
The calibrant list shows names and masses of known substances, the corresponding 
masses found in the currently active spectrum, and the error in ppm and in Dalton.  
Interactive Calibration can be done automatically with the button  or 
manually with click in the list on one calibrant followed by a click in the spectrum left to 
the corresponding peak. Masses of the peaklist are then filled in the calibration list and 
the error is re-calculated with each new assignment. The error in Dalton is calculated 
with , the error in ppm is calculated with ( massreferencemasscurrent − )

610*


−
massreference

massreferencemass



 current
. 

 
Mass Control List Selection: 
This pull down menu contains the available mass control lists (MCLs). Only lists with at 
least one mass marked as calibrant are offered. The calibrants of the selected list are 
displayed in the box below.  

Button   
Applying this button opens the Mass Control List Editor (Figure 46), as also the 
button on the Recalibration Masses tab (Figure 73) in the parameter Editor does 
(section 2.4.7.6.3). MCLs can be changed and created with this editor. For more 
information on how to use and create MassControlLists have a look in the 
Quickstart_MassControlLists_Compass_1.2.pdf available on the Compass for flex 
installation CD. 

 

Figure 46 Mass Control List Editor 
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Peaks from the peaklist are automatically assigned to the reference masses; a new 
fit result and errors are calculated but not yet applied to the spectrum. If no peaklist 
is available, this is automatically created before the assignment. The peak finder 
algorithm used for automatic calculation is the one currently selected in the 
processing parameter editor (section 2.4.7.6.1). 

  
With a click on this button the new fit result, calculated with manual assignment or 
the button “Automatic Assign” is applied to the spectrum (it is moved in the display). 

  
After the new fit result has been applied with “Preview” it can be cancelled with the 
“Undo” button. The original calibration, currently saved in the spectrum is applied 
again and peaks are re-annotated.  

  
This button deletes the assignments from the calibration list; it does not touch the 
possibly done calibration. 

  
After a calibration has been done, the dialog can be closed with these buttons. “OK” 
means “Preview and Close”, so even if the “Preview” button has not been applied 
the calibration is accepted. “Cancel” means “Undo and Close”, i.e. even if the 
calibration has been applied with “Preview” before, it is not accepted. 

  
For manual assignment of masses to reference masses it is necessary to click in 
the spectrum left to the peak of interest. Therefore it is helpful to zoom 
automatically the respective mass range corresponding to the selected reference 
mass. It is possible to choose between some relative and absolute zoom ranges. 
Note: You can use the mouse wheel to select the next reference mass (or to go 
back to a previous one). This simplifies the manual assignment. 

Peak Assignment Tolerance  
The tolerance defines a mass interval that is used for the calibrant assignment. If 
the difference between a reference mass and a peak in the peaklist is smaller than 
the tolerance, the peak is assigned to the calibrant.  If more than one peak of the 
peak list fits this criterion the peak with the smallest mass difference to the calibrant 
is assigned to the calibrant. 

Calibration Fit Order  
Selecting this option performs a quadratic or linear calibration calculating the 
coefficients c0, c1 (and c2). For linear calibrations c2 is set to zero. 
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The Properties dialog shows the current state of the calibration and some general 
calibration information. If spectra have been acquired with a flexControl HPC 
method the check box “High Precision Calibration applied” at the bottom  is 
activated (read-only check box). The decision whether the HPC calibration is used 
or not is done via the Options dialog (section 2.4.10.10.4) from the Tools menu.  

 

Figure 47 Calibration Properties dialog 
Result Information  

Below the calibration list three result fields are shown: the number of used 
calibrants, the standard deviation before and standard deviation after the last 
calibration fit. 

 
If no peaks are found during the automatic peak assignment the following message 
appears where possibilities are offered to correct the calibration.  
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Figure 48 Message to repeat automatic assignment with different 
conditions 

Smart Calibration  

 

Figure 49 Mass Spectrum Calibration dialog – Calibration Strategy “Smart” 
If the option Smart Calibration is selected the calibration dialog looks as shown in 
Figure 49. 

SMART is an "intelligent" calibration strategy, which significantly improves the 
identification success and the scores for PMFs (Peptide Mass Fingerprints). SMART 
calibration requires project specific mass control lists for calibration and background 
peak exclusion. Such lists are generated with Bruker ProteinScape software or, on 
individual customer request, by the Bruker Software support 
(maldi.sw.support@bdal.de). Common mass control lists are not suited for SMART 
calibration (exception: PAC_PeptideCalibStandard.mcl).  
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The SMART calibration is an iterative process which takes the following points into 
account: 

� the number of calibrants found in the respective spectrum, 

� the likelihood of these calibrants appearing, 

� the accuracy of the mass values, as well as their distribution over the required 
calibration mass range. 

The project dependent mass control lists do not only include the peptides, whose 
sequences and theoretical masses are known (e.g. trypsin autolysis products, and 
keratin fragments), but normally a large number of background peaks. Their sequence 
is not known, and their masses are determined by the average obtained from a large 
number of well calibrated spectra obtained during such a project. Such background 
peaks are project specific and are very dependant on sample preparation (digestion 
method, staining method and preparation). 

Statistical Peptide: 
The third calibration strategy, Statistical Peptide, is only useful when peptide spectra 
are calibrated. 

 

Figure 50 Mass Spectrum Calibration dialog – Calibration Strategy 
“Statistical” 

Statistical Peptide is a so-called self-calibration of TOF peptide spectra. It is a 
powerful tool, especially in cases, where no internal calibrants are known. 

Note: A statistical calibration needs no calibrant list!  

This strategy is based on the fact that the monoisotopic masses of peptides are 
distributed in a very regular way, at least in the mass range, which is used for protein 
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digest measurements. The masses accumulate around masses mmean at a distance of 
approximately 1.00048 Da. The masses mmean are used as calibrants for all peaks in 
the mass list in a statistical calculation of the new calibration constants.   

Golden rules for statistical calibrations: 

Statistical calibrations are applicable for peptides only.  Under good conditions a mass 
error of 20 - 40 ppm can be reached. 

The more peaks are available in the mass list and the better is the distribution of these 
peaks over the mass range of interest, the better is the result of the statistical 
calibration. As a rule of thumb about 20 peptide peaks are needed to obtain a 
meaningful result.  

The maximum mass error of the peaks must not exceed about 0.4 – 0.5 Da (500 ppm 
at 900 Da). At about 0.5 Da the algorithm cannot decide which mass is concerned.  
This can lead to an incorrect calibration of one Da! 

If your feel certain that the external calibration of the given spectrum is significantly 
better than 500 ppm you can reduce the peak assignment tolerance accordingly.  This 
can slightly enhance the performance of the statistical calibration.  

Strong matrix cluster peaks between 700 and 1500 Da can affect the quality of the 
statistical calibration results.  This happens because the stoichiometric composition of 
matrix clusters and peptides are strongly different. 

2.4.5.3 Copy Calibration 

With this command the calibration constants of a spectrum can be copied into the 
clipboard. Afterwards they can be pasted to another analysis. 

1. Select an analysis in the Analysis List Window. 

2. Select Copy Calibration. The command copies the calibration of the 
selected analysis into the calibration memory of flexAnalysis. Afterwards it can 
be pasted to other analysis/analyses. Only MS finger print calibrations can be 
copied and transferred into the calibration buffer.   
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2.4.5.4 Replace Calibration 

The Replace Calibration command transfers the calibration from the calibration 
memory to the selected analyses. 

Precondition: A TOF calibration, i.e. the constants c0, c1, and c2 of an analysis have 
already been copied into the calibration memory of flexAnalysis. 

1. Select on ore more analysis/analyses in the Analysis List Window. 

2. Select Replace Calibration. The calibration constants are transferred. 

Before a calibration is transferred from one analysis to another one, it is checked 
whether the high voltages of the ion sources 1 and 2, the lens and reflector voltages of 
the two analyses are identical within a range of 0.01 V.  If this is not the case a warning 
message appears.  Press “No”, if you don’t want to transfer the calibration and “Yes”, if 
you want to apply the external calibration despite of the mismatch of the calibration 
voltages. 

This describes the manual way to do a calibration and transfer it to a set of sample 
spectra. Automatically can this be done (within an AutoXecute run) with two pre-
installed methods: CalibratePeptideStandards.FAMSMethod and 
ExternalCalibration.FAMSMethod. 

The first one is applied to spectra acquired on a calibration sample; the script of this 
method cares for the calibration process and the copying of the new calibration 
constants. The second method is applied to spectra that are acquired on the sample 
spot after (!) the calibration measurement. The script cares for the transfer of the newly 
calculated calibration constants.  

2.4.5.5 Apply Raw Calibration 

The Apply Raw Calibration command is used to reset the calibration to those 
values, which were originally stored during the acquisition. The peak list will be re-
calculated. This command is only applicable for MS- and FAST-segment spectra.  After 
applying and before executing this command a warning message (Figure 51) appears. 

 

Figure 51 Warning before applying the raw calibration 
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2.4.6 Annotation Menu 

 

Figure 52 Content of the Annotation Menu 
The Annotation Menu (Figure 52) is composed of various commands that allow you to 
attach specific annotations to mass spectra, to modify these annotations and to remove 
them again if you do not want them to be saved with the respective mass spectrum. 

2.4.6.1 Overview 

Table 6  Features of the Annotation Menu 
Feature 
button 

Method Menu 
commands 

Shortcut Description 

    

 Annotate Alt Activates the Annotation mode. 

 Clear  Deletes all annotations from the display and 
from the Sequence List. 

 
Show mass 
differences  Hide/display mass errors relative to theoretical 

mass differences   

 
Preview 
Assignments  Spider web mode: screen for all possible next 

peaks automatically  

 
Edit Building 
Blocks  Opens the Building Block Editor 

 

An annotation is attached to one (single-point annotation) or two (difference annotation) 
selected data points and is defined by its position in terms of the data coordinates 
(intensity and mass). Therefore, when the display range is changed, an annotation 
moves along with its associated mass spectrum. Annotations can be attached to any 
peak of the peaklist. 
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Each annotation consists of a value or text entry and a line marker that indicates the 
m/z value(s) the respective annotation relates to. 

Different annotation types are available depending on the kind of data you wish to 
annotate. Mass spectra peaks can be annotated with their corresponding m/z, values 
of m/z difference, building block information or text. 

2.4.6.2 Annotate 

The Annotate command, the corresponding icon  of the toolbar and the shortcut 
(Alt) are used to activate the Annotation mode. The toolbar is expanded with the 
Annotation features shown in Figure 53. 

 

Figure 53 Annotation toolbar 
These toolbar features are pre-installed, some others, concerning the annotation font 
and orientation, can be additionally selected (Customize Toolbar, section 2.4.10.9). 

�   
This Drop down box offers all available Building Block Sets (the sets can be edited 
with the Building Block editor). Select a set from the list that possibly contains 
building blocks that match to the currently selected spectrum. 

�   
The Building Block Search Tolerance has to be entered manually; it is possible to 
change between Dalton and ppm. The Tolerance is used for the preview 
assignment feature (section 2.4.6.5).  

�   
The field Annotation Text can either be filled manually with any text (that is then 
transferred into the display) but it is also filled automatically with the Building Block 
information that belongs to the Annotation that is just activated in the display 
(mouse click). Depending on the selection of the Abbreviation Box (see below), the 
full name, symbol or abbreviation of the Building Block is shown.  

�   
The selection in the Abbreviation Box for Building Blocks determines whether the 
Symbol, Abbreviation or the Full Name of the currently activated Building Block is 
shown in the display and in the Annotation Text field. An example is shown in 
Figure 54.  
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Figure 54 Example of different annotations texts 

� , :   
The font and font size, as well as the position and orientation of the annotations can 
be determined with these features. The color of the Annotation label can be 
changed via the Tool menu entry “Colors …”. 

2.4.6.3 Clear 

The Clear command and the corresponding icon  of the toolbar are used to delete 
all Annotations from the spectrum display, as well as the possibly resulting sequences 
from the Sequence list. 

2.4.6.4 Show Mass Difference 

The Show Mass Difference command and the corresponding icon  of the 
toolbar are used to show mass differences additionally to the respective Annotation 
(name, symbol or abbreviation) in the display. This value shows the mass difference 
between an assigned building block and the actual mass difference between the two 
chosen peaks.  
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Figure 55 Annotation with and without Mass Difference 

2.4.6.5 Preview Assignments 

The Preview Assignments command and the corresponding icon  of the 
toolbar offer a preview on all possible distances (to higher and lower masses) 
depending on the entered search tolerance that can be calculated for one (!) starting 
peak together with the selected Building Block set. An example is shown in Figure 56. 
To see the preview for one mass 

� make sure that you have a peaklist 

� activate the Annotation mode and activate the Preview Assignments 
button 

� click on a peak in the spectrum display and keep the left mouse button pressed. 

→ The matching Building Blocks will be shown. You can choose one of these and 
release the mouse button to get this annotation. 

 

Figure 56 Example for possible assignments for the peak 517.18 Da 
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2.4.6.6 Edit Building Blocks 

The Edit Building Blocks command is used to start the Bruker Daltonics 
BuildingBlockEditor application which allows you to view and edit the currently 
available building block sets to be used to automatically interpret m/z differences. 

Selecting this command starts the BuildingBlockEditor and loads the first of the 
alphabetically ordered building block sets shown in Building block sets. The building 
blocks contained in this set are listed in Building Blocks along with their Full name, 
Abbrev(iation) and chemical Formula. Additionally, the Symbol is shown which appears 
in the data window when the Annotation mode is active. 

Various Bruker Default building block sets are available. A <BrukerDefault> appendix 
to the building block set name indicates these. You cannot alter or delete them. 
However, you can set up user specific building block sets by copying such a Bruker 
Default set to a new file name and then modifying the copy according to your own 
requirements or by creating a completely new building block set 

 

Figure 57 Building blocks contained in the loaded building block set 
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2.4.7 Method Menu 

 

Figure 58 Contents of the Method Menu 
The Method Menu (Figure 58) is composed of various commands to configure method 
parameters. 

2.4.7.1 Overview 

Table 7  Features of the Method Menu 
Feature 
button 

Method Menu 
commands 

Shortcut Description 

    

 Open  Opens a processing method. 

 Save  Saves the open processing method with the 
same file name if not write protected. 

 Save As  Saves the open processing method with a new 
file name. 

 Run Script F2 Runs the Sax Basic script of the open 
processing method on the selected analysis. 

 Parameters Alt + F2 Opens the method parameter editor. 

 Script Ctrl + F2 Creates or edits the Sax Basic script that 
belongs to the open processing method. 

 Select Default  Opens a dialog to select automatically 
attached default processing methods.  
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Methods are central elements in flexAnalysis.  They determine the processing of the 
analysis.  An analysis is always associated with one method.  This assignment takes 
place during the load process and depends on several criteria. 
First of all it depends on whether the analysis has already been processed and saved 
with flexAnalysis or not.  If the analysis has once been saved with flexAnalysis a file 
called analysis.FAMethod was created (next to the fid file in the spectrum tree) that 
contains all method settings (parameter and script) that were active at saving time. This 
file is loaded when the analysis is opened again. In this case the spectrum sample 
name is shown in the status bar at the bottom of the GUI. 
If the analysis has never been saved with flexAnalysis before the program checks 
whether the acquisition program flexControl (“Save As” dialog) or AutoXecute 
(Processing tab) has specified a flexAnalysis method after the acquisition. In this case 
this method is assigned.  If the assignment fails either because the method is broken or 
does not exist the Default Method (see 2.4.7.8) is loaded, since it is not possible to 
open a spectrum without a method. In all these cases the name of the method is shown 
in the status bar at the bottom of the GUI, at least as long as the script is running. 
In some cases the assignment of the Default Method may fail, too. Then so called 
Default Values (and an empty script) are loaded to have access to the data and to 
assign working methods manually. This failure is shown with the information <Default 
Values> in the status bar at the bottom of the GUI. 
A method consists of two parts, the method parameters (section 2.4.7.6) and the 
method script (section 2.4.7.7). The method script determines the sequence of 
processing procedures performed with your analysis, while the method parameters 
configure each processing procedure. 
Note: The peaklist layout is also a method parameter. 
If an analysis that has never been processed in flexAnalysis before is opened the 
method script is executed automatically and the “Script in progress” dialog is shown 
(Figure 60).  
To get more information on the “flexAnalysis method concept” please refer to the 
Quickstart “flexAnalysis Method Concenpt.pdf”.   

2.4.7.2 Open 

The Open command and the corresponding icon  of the toolbar are used to open 
the Open flexAnalysis Method dialog (Figure 59) to choose a new flexAnalysis 
method.  The new method replaces the previous one. The name of the current 
processing method is displayed in the status bar of the GUI (section 2.3) title bar of the 
Method Parameters dialog box (Figure 61), that appears when selecting the Edit 
Parameters command from the Method menu, as well as in the title bar of the 
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Method Script Editor (Figure 77) and in the status bar of the GUI. Here it is displayed 
as long as the analysis has not been saved.  

 

 

Figure 59 Open flexAnalysis Method dialog box 
How to assign a method: 

There are different ways to assign a new method to a selected analysis. This may be 
required if it is necessary to use a method that is different to the current method 
settings.  

Assigning a method with the open command: 

1. 

2. Click 

Select the analysis that shall obtain a new method. 

 . 

-or- 

1. 

2. 

3. 

From the Method menu, select Open. 

Select the method you want to attach. 

Click “Open”. 

Attaching a processing method of another analysis with copy and paste (section 2.4.2):  
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It is not required that this method exists in the flexAnalysis methods directory, for a 
saved spectrum the method Analysis.FAMethod (from the spectrum tree) is used: 

1. 

2. 

Select the analysis whose method you want to attach in the tree view. 

Right-click the selection and select “Copy” or Click . 

3. 

4. 

Select the analysis that shall obtain a new method. 

Right-click the selection and select Paste or Paste Special or Click . 

2.4.7.3 Save 

The Save command, or the corresponding icon  of the toolbar are used to save 
changed method settings to the same file name.  This overwrites the original (not write 
protected) method.  If the opened method has been changed but not saved, it is shown 
by the '(modified)' indicator, a *-symbol, which is shown in the title bar of the Method 
Parameters Dialog box or in the Script Editor.  If a modified method is not saved the 
current parameter settings for an analysis will be saved when this analysis is saved.  
The file Analysis.FAmethod is created in the analysis tree. 

Selecting the Save command removes the '(modified)' indicator previously appended 
to the title bar of the method editor.  

Note: If the original method is write-protected the Save command is not accessible 
and the Save As dialog opens.   

2.4.7.4 Save As 

The Save As command is used to create a new processing method by saving a 
changed method to a new or already existing file name. Enter a new or select an 
existing processing method name in the appearing dialog. 

The new file name will be displayed in the status bar at the bottom of the GUI and in 
the title bar of the corresponding Method Parameters Dialog box instead of the 
previous method name. 

2.4.7.5 Run Script 

The Run Script command, the corresponding icon  of the Toolbar, and the 
short cut (F2) are used to run the Sax Basic script that belongs to the currently loaded 
method of the selected analysis.  
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The running of the script is indicated by the dialog shown in Figure 60.   

 

Figure 60 Running method script 
The script processes the spectrum according to the particular processing operation(s) 
and parameters defined in the script and the parameter editor, respectively. 

To view a script before running, the flexAnalysis Script Editor (section 2.4.7.7) can 
be opened.  The script can then be started directly from here. 

2.4.7.6 Edit Parameters 

The Edit Parameters command, the corresponding icon  of the toolbar, and 
the short cut (Alt + F2) are used to open the Parameter Editor.  According to the 
selected kind of spectrum (MS, LIFT, and FAST) in the Analysis List Window the editor 
offers a variable number of tabs with respective features. 

Note: All features contained in section 2.4.7.6 are method parameters. If one 
parameter is changed and the currently active spectrum is saved, the settings are not 
automatically available for other spectra! If you want to use a special set of parameter 
for all your spectra, you have to create a new method and save it with a new name. 

2.4.7.6.1 Process 
The Processing Method selected and adjusted here determines the results of all 
processings that affect the peaklist. As long as the selected spectrum has not been 
saved the name of the chosen Processing Method is shown in the dialog. After the 
spectrum is saved the sample name is shown (analog to the method name/sample 
name shown in the status bar before and after the spectrum is saved). 
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Figure 61 Process tab 
Since “Compass 1.2 for flex”, i.e. flexAnalysis and flexControl 3.0 the peak detection 
algorithms as well as processing settings like baseline subtraction and smoothing are 
defined in Processing Methods (*.prp) that are edited via the Processing Parameter 
Editor (Figure 62). These parameter containers can be created, edited and used from 
flexAnalysis, flexControl and AutoXecute. Detailed information can be found in the 
corresponding Quickstart_ProcessingParameterMethods.pdf. 

Mass List - Find 
The flex programs support three different detection algorithms: Centroid, SNAP, and 
Sum. These are used to detect mass peaks, calculate the corresponding m/z values 
and many other peak parameters, such as intensity or resolution. 

 

Figure 62 Processing Parameter Editor - Mass List Find 
Any peak finder is optimized for a specific task. In most cases if the elementary 
composition is known (Figure 65), it is recommended to use SNAP for detection of 
groups of isotopic peaks.  Centroid is often used in case of protein spectra and benefits 
in defining mass accuracy. The Sum Finder is used for time critical applications.   

The following four parameters are the same for all algorithms: 

Signal to Noise (S/N) Threshold: 
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The S/N is defined as the height of the mass peak above its baseline relative to the 
standard deviation of the noise, i.e. peak height / (3 x σ)  (σ: standard deviation of the 
noise).  The higher the threshold the less peaks are found.  However, if the selected 
value is too small, noise may be regarded as peaks.  The recommended S/N range 
varies from 3/1 to 10/1.  In case of 10/1 you can be sure to have eliminated nearly all 
the noise. 

Relative Intensity Threshold: 

The Relative Intensity Threshold is a level in percent referring to the base peak, which 
is the largest peak in the spectrum.  In cases, where it is not clear, whether the base 
peak refers to the sample or not, the recommended value for this threshold is 0 (zero). 

Minimum Intensity Threshold: 

A peak must have at least this intensity to be detected and annotated from the peak 
finder. It is useful for example for Imaging runs where the fuzzy control is de-activated 
and spectra that only consist of electronic noise are acquired. They show a flat 
baseline and some spikes with small intensities that will be annotated and will distort 
the picture. The Minimum Intensity Threshold allows ignoring these. 

Maximal Number of Peaks: 

This is the maximal number of peaks that shall be detected by any of the three 
detection algorithms.  In case of SNAP this value is an additional filter regarding the 
Quality factor, for all other algorithms the peaks with the highest intensity will be 
selected. 

Additionally each peak detection algorithm has also some special parameters that can 
only be adjusted, if the respective algorithm has been chosen from the drop down list. 

Peak Detection Algorithm Centroid  

The peak finding mechanism for Centroid (Figure 63) uses the first and second 
derivative to detect a peak. For the peak position a specific cut off level above the 
baseline, Percent Height, has to be specified. A value around 80% is recommended. 
The baseline is subtracted automatically when using Centroid. The baseline subtraction 
algorithm has to be selected on the Mass List Find tab. 

Note: The algorithm chosen here is not used for the “real” baseline subtraction. 

Other special Centroid parameters are: 

Peak Width: 

The parameter Peak Width is no threshold but an expectancy value. Peaks having this 
width are expected in the spectrum and will be accepted. If the width value is set too 
high, small peaks will be regarded as noise. 
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Height: 
This value determines the upper part of the peak that is used to locate the peak 
position on the x-axis, i.e. m/z. If the separated peak area is symmetric the peak 
position will be found centric, otherwise the maximum is shifted. 

 

Figure 63 Method parameters dialog box (Mass List Find: Centroid) 

Peak Detection Algorithm SNAP  
SNAP (Sophisticated Numerical Annotation Procedure, Figure 64) searches for known 
patterns in the measured spectrum and performs its own internal baseline correction 
and noise determination.  Therefore it is necessary to use SNAP together with raw data 
that have never been processed before, i.e. no baseline subtraction and no smoothing. 

With SNAP groups of peaks are detected in high throughput proteomics, e.g., for 
identification of isotopic patterns and exact calculation of the monoisotopic masses.  
Monoisotopic masses are the basis for database search and DeNovoSequencing, 
which allows elucidating structure and sequence of a particular peptide if database 
search for MS/MS data failed. 

SNAP calculates the isotopic distribution of a given mass, charge and mean molecular 
constitution and uses the resulting isotopic pattern for a nonlinear fit that delivers the 
monoisotopic mass in the end.  
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Figure 64 Method parameters dialog box (Mass List Find: Snap) 
Quality Factor Threshold: 

The parameter Quality Factor Threshold describes the reliability of a peak.  It is a 
composition of peak intensity and consistency with known isotopic patterns. It is not 
possible to give a recommendation for this value; the best is to have a look on it in 
some representative spectra and find out the size. 

SNAP average composition: 

The drop down menu SNAP average composition allows selecting a composition. 
Existing compositions can be modified; compositions of other averaged substance 
classes can be added.  Modifications of Bruker defaults have to be saved to a different 
name.   
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Figure 65 List of SNAP average compositions 
For peptide applications a composition called “Averagine” is defined.  The conceptual 
meaning of the word Averagine (Figure 66) and the term C 4.9384 N 1.3577 O 1.4773 
S 0.0417 H 7.7583 is the averaged composition of molecules of the 21 amino acids 
corresponding to their abundance ratio. This creation is denoted the first Building Block 
and is always located in the first row (Figure 66). 

To edit a Building Block click . 

 

Figure 66 The pre-installed average composition Averagine 
SNAP uses this average composition as often as it is necessary for approximation to 
the molecule under investigation.  If a second composition is defined that is a mass 
existing only once in a monomer, SNAP uses this one exactly once for mass 
determination.  The Second Building Block is always located in the second row (Figure 
66).   

Fragment Peak Width: 

This parameter is used to confine a peak to a particular width thus excluding broader 
peaks from the peak list.   

SILE Mass Difference(s) (H –L) : 
Enter one or more values (separated by a semicolon) to define the mass difference 
between the Heavy (H) and Light (L) isotopes of the labeling reagent. 

The SILE mass difference(s) defines the m/z distance between the two or more 
labelled forms. E.g. for 18^O digest labeling it would be one and two times 

m/z (18^O) - m/z (16^O) = 2.004 and 4.008. 
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The knowledge about the SILE mass differences is used for an improved S/N 
thresholding and the internal judgment of the presents of overlapping monoisotopic 
peaks. 

SILE Partner SN Threshold: 
The SILE Partner S/N Threshold allows the definition of a second S/N threshold which 
is checked for SILE partners. If there are two SILE partners only one has to match the 
normal threshold. For the second partner it is enough if it is large enough to match the 
SILE partner SN threshold. This gives a better dynamic range for the observable 
regulation without adding too many noisy peaks. 

Peak detection algorithm Sum  

The Sum peak finder (Figure 67) uses a time-saving approach while calculating so-
called pseudo derivatives instead of real derivatives as known from Centroid.  If the 
pseudo slope exceeds a certain threshold, a peak is regarded as peak. The Sum 
algorithm makes internal use of the configurable baseline correction and noise 
calculation to select peaks and to calculate signal-to-noise ratios. The configurable 
parameters are explained with the other algorithms. 

 

Figure 67 Method parameters dialog box (Mass List Find: Sum) 
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Mass List Edit 

 

Figure 68 Mass List Edit – use Mass List Find as sensitive as possible  
The main difference between the Mass List Edit tab and the Mass List Find tab is the 
checkbox “Use specific parameters for peak picking”. If this checkbox is not selected 
(Figure 68) all parameter settings that are currently selected in “Mass List Find” are 
used for the Mass List Edit procedure, except the Threshold parameters, which are 
set to zero. This has the effect that the peak finder, which was used for a Mass List 
Find, is as sensitive as possible in order to detect additional peak with Mass List Edit 
manually.  

 

Figure 69 Mass List Edit – define special values 
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If the checkbox is activated (Figure 69) different parameters can be selected. The Edit 
field Maximal Number of Peaks is deactivated because only one peak is detected at a 
time. 

Processing Smoothing 
The settings for Smoothing process (section 2.4.4.2) can be adjusted in the section 
Smoothing.  flexAnalysis supports three different smoothing algorithms: Savitzky-
Golay, Gauss, and Chemical Noise.  Which one is used depends on the application.   

 

For all filters the smoothing Width can be chosen. The Width range is from 0 to 100, 
the user is asked to find out the best fitting value. 

The Cycles determines the number of smoothing processes on one analysis.  One 
cycle is recommended. This parameter is not applicable together with the algorithm 
Chemical Noise. 

The idea of the Savitzky-Golay algorithm is to calculate polynomials in the 
neighborhood of each data point to get a smoothing of the data. This can be formulated 
as  

kik

M

Mk
i ycy +

−=
∑=:~  

with coefficients . The parameter M in the formula is calculated from the given m/z 
smoothing width. The number of smoothing cycles can also be chosen which gives the 
option to apply this smoothing filter multiple times. 

kc

     

Figure 70 Method parameters – Smoothing 

Processing Baseline Subtraction 
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The settings for Baseline Subtraction processes can be adjusted in the section 
Baseline Subtraction (section 2.4.4.3). Three different algorithms are offered: 
ConvexHullV3, Median and TopHat. 

 

Figure 71 Method parameters – Baseline Subtraction 
The algorithm Median is determined through the parameters Flatness and 
MedianLevel. A spectrum that will be baseline subtracted is divided into a number of 
segments. The minimal number of segments is 1, i.e. Flatness equals zero. The 
maximal number of segments is 100, which corresponds to a Flatness of 1.  A strong 
baseline drift is associated with high Flatness values.  

The parameter Flatness influences the number of parabolas used to explain the 
baseline and the flatness of the resulting spectrum, which is obtained by subtracting 
the baseline from the spectrum. The larger the flatness value the finer the baseline will 
approach the spectrum.  

The following values are recommended for Flatness: 

0.0  for totally flat spectra without baseline drift, 

0.1 for protein spectra, and 

0.8  for digest spectra, recorded in reflector mode. 

The Median Level allows shifting the baseline relative to the data. By definition, if we 
have 100 data points, the median (a common statistical size) is the value of data point 
50 after the data points are sorted by their y values. If we have a very dense spectrum, 
then the sorted data point #50 can already be something that is in the data level, well 
above the baseline. In these cases, we can tell the software not to use the median as 
defined (data point #50), but, say, use the value of data point #30, which is then 
supposed to be part of the baseline, and not part of the data. 

The algorithm ConvexHull3 constructs the baseline by fitting multiple parabolas to the 
spectrum starting with the large scale structures. The baseline is then refined in an 
iterative way. This is done in a way that the baseline is at least almost always below 
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the spectrum; therefore the name Convex Hull baseline. The baseline Flatness 
parameter influences baseline construction. 

ConvexHull is usually preferred for a mass range of up to 10 kDa. The advantage of 
this algorithm is that the baseline is a smooth function. 

The algorithm TopHat constructs the baseline by means of morphology operators. The 
baseline of the spectrum is obtained in two steps: first each data point is replaced by 
the minimum value of the spectrum within n data points, which gives the so called 
“erosion”. Then within the same number of data points, each value is replaced by the 
local maximum of the minimal values giving the “opening” of the spectrum, which is the 
baseline. The number of data points over which the minimum and maximum value is 
searched for is a function of the mass and is increasing in a way to get a good removal 
of the baseline but to minimize the distortion of the peaks. 

TopHat should not be used for Protein spectra. 

2.4.7.6.2 FAST (only for FAST Segment Spectra) 

 

Figure 72 Method parameters dialog box (FAST) 
The FAST tab shown in Figure 72 is only available for a FAST Segment analysis.  This 
tab allows deciding if smoothing and baseline subtraction are performed before the 
FAST segments are pasted. If both functions are selected first smoothing is performed. 
The algorithms used for these processings are taken from the Process tab. 
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2.4.7.6.3 Recalibration Masses (only for MS Spectra) 

 

Figure 73 Method parameters dialog box (Recalibration Masses) 
The parameters selected and adjusted in the Recalibration Masses tab determine the 
results of the internal calibration. The settings correspond to the settings in the Internal 
Calibration dialog (section 2.4.5.2). The Recalibration Masses tab is used in context 
with methods and automation, the Internal Calibration is used for manual calibration. 
Select first the calibration strategy you want to use.  
The adjustable parameters on this tab have been explained in detail in section 2.4.5.2. 
The pull down menu Mass control list contains predefined mass control lists that can 
be used for recalibration. The lists can be modified with the “Edit” button. The Mass 
Control List Editor opens and shows the selected list (Figure 74).   
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Figure 74 Mass control list editor 
Peaks can be marked as Calibrants and/or as Background peaks by activating the 
corresponding checkboxes.  
Note: 

• Only lists with at least one mass marked as calibrant appear in the drop down 
menu Mass control list. 

• Only if peaks are marked as background peak, they can be identified from a 
peaklist via the macro Identify Background Peaks (section 2.4.3.7). 

• The Tolerance values are used for Background identification as well as for 
calibrant assignment. 

• The columns Lock and Adduct are not yet in operation!    

Apply  to import an entire peaklist into the editor. This list may be saved 
and also used as mass control list.   
A pre-installed, i.e. write protected mass control list can be saved with another file 
name.  The new file is added to the MassControlLists directory and can now be used 
from all programs that work with MCLs.  
The same mass control lists that are available in flexAnalysis are also available in 
flexControl (Calibration tab) and autoXecute (Evaluation tab). So, if a list is 
changed in one of these programs, this change is also available in the other programs. 
For information about the other features of the Recalibration Masses tab please refer 
to section 2.4.5. 
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2.4.7.6.4 Mass List Layout 

 

Figure 75 Method parameters dialog box (Layouts) 
flexAnalysis offers 10 parameters that may be displayed in the Mass List Window. 
The choice can be done via the Layout tab. The layout is part of the flexAnalysis 
method.  So if you want to change it permanently for use with other spectra save the 
method (!) afterwards.  If only the just opened analysis is saved, the layout setting 
refers only to this analysis (because it is saved in the file Analysis.FAmethod that only 
belongs to this analysis). 

• The pull down list can be opened with the button “New (Insert)” . 

The button “Delete”  is used to remove a peak property from the Mass List 
Window.  

• 

The button “Move Up”  or the related short cut (Alt + Up Arrow) and 

the button “Move Down”  or the related short cut (Alt + Down Arrow) 
are used to change the arrangement of the displayed peak properties.    

• 

 
Note:  Some peak finding results are specific to a certain peak finding algorithm, 
e.g. the Quality Factor. If the parameter column is shown and the peaklist has been 
created for example with SNAP, the Quality Factor column remains empty.  
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2.4.7.6.5 Display  

 

Figure 76 Method parameters dialog box (Display) 
In this dialog the number of displayed digits for masses in the display and the Mass 
List Window (peaklist) can be changed. 

Checkbox “Replace Original”: 
When this box is activated (default setting) the new result spectrum (after baseline 
subtraction or smoothing) replaces the previous original spectrum in the Analysis List 
Window.  The spectrum color remains the same.  No additional spectrum is displayed. 
If this box is not selected an additional spectrum is attached to the treeview with 
different color due to the color hierarchy.  

2.4.7.7 Edit Script 

The Edit Script command and the short cut (Ctrl + F2) are used to open the 
flexAnalysis Sax-Basic Script Editor. This is an interactive design environment to 
develop, test, and execute Sax-Basic scripts. Sax Basic is Visual Basic for 
Applications™ compatible. Scripts are used to process analyses automatically.  In the 
flexAnalysis environment, scripts are part of an analysis or a method.   

The contents of a script are normally processing instructions for a particular analysis 
the method belongs to.   

General information about Sax Basic Scripting can be found in the corresponding Help 
file. For detailed information about Sax Basic Scripting please refer to the flexAnalysis 
Scripting Manual (PN 227119). 

On launching the Script Editor flexAnalysis loads the script of the processing method 
currently assigned to the selected analysis. The Script Editor's title bar shows the name 
of the open processing method and the analysis name in parentheses.  In case of a 
modified but not yet saved method, the '(modified)' indicator is appended to the method 
name. 
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Figure 77 Example of a Basic script 

2.4.7.8 Select Default 

Every spectrum that is opened in flexAnalysis needs to have a flexAnalysis method. 
This method is automatically assigned on different ways (depending on save processes 
in flexControl, AutoXecute, or flexAnalysis that occur before), so the user is not 
requested to do anything. 

During the manual saving in flexControl or during AutoXecute runs it is possible (and 
sometimes recommended) to indicate flexAnalysis methods that are used for post 
processing later on. If no method has been indicated each spectrum automatically gets 
a default method assigned during the load process. This default method is determined 
in the dialog Default Method Selection. For any of the four possible spectra types, 
suitable methods are available (Figure 78). 

 

Figure 78 Default methods that are assigned to spectra that have no 
method 
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The methods “ParametersOnly” contain a set of suitable parameters and an empty 
script. For this reason (empty script → no commands) no processing and especially no 
saving takes place if a spectrum gets “ParametersOnly” assigned. 

The pre-installed default settings are PMF for MS spectra and SNAP_full_process for 
LIFT spectra. Certainly this can be changed, especially if the user does not want a 
script running for every spectrum that is newly loaded. 

 

 

2.4.8 FAST Menu 

 

Figure 79 Contents of the FAST Menu 
The FAST Menu offers FAST specific operations and is only available if a FAST 
segment analysis or FAST analysis is unambiguously selected. For all other spectra 
types the menu entries are not selectable. To display FAST segments with their correct 
mass values flexAnalysis is capable to recognize the analysis type during loading.  

2.4.8.1 Overview 

Table 8  Features of the FAST Menu 
Feature 
button 

Mass List Menu 
commands 

Shortcut Description 

    

 Paste Segment 
Spectra  Pastes all segments to one spectrum. 

 Change 
Parameters…  To change parent and segment 

parameters. 

 Delete Segment 
Spectra  Deletes segment spectra from hard disk. 
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2.4.8.2 Paste Segment Spectra 

The Paste Segment Spectra command is used to paste FAST segment spectra 
to one linearized FAST spectrum as.  

Raw data (fids) are used in the paste process. The following rule is applied for pasting:  
First flexAnalysis uses the penultimate segment (n-1) until mass mmax, and then 
follows the last segment (n) without overlapping both segments.   

       

Figure 80 Example of a segment spectrum before and after pasting 
The paste procedure results in a new analysis that is also shown in the tree view. This 
analysis contains all spectra, which arise from multiple use of the Paste command 
referring on the same FAST segment analysis. 
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Figure 81 New analysis containing two pasted spectra 
Results are not automatically saved after manual pasting. On saving an analysis, which 
contains the result of a paste procedure, a result spectrum of this analysis is saved in a 
directory: samplename\<parentmass>.FAST.FAST. Only the pasted spectrum shown in 
bold letters (in the tree view) will be saved with the Save command.  
Note: If there is already a spectrum in samplename\<parentmass>.FAST.FAST it will 
be overwritten, because on the hard drive at any time only one result spectrum is 
allowed. 

2.4.8.3 Change Parameters 

The Change Parameters command is used to change the parent mass, the FAST 
segment parameters per segment, for example the segment range, and to recalibrate 
FAST segment spectra afterwards. The operator can apply a new calibration file for 
recalibration in case of Segment Spectra acquired with flexControl versions < 2.0.   

The Change Parameters command opens a dialog that lists the segment 
boundaries in m/z. Applying the radio button “FASTLow / FASTHigh” the same 
segment boundaries are shown in the relation FASTLow / FASTHigh. 
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Figure 82 Changing segment ranges using m/z values 

The feature button in the right upper corner  opens a dialog to load a FAST 
Segment Calibration File (<name>.psd).  This feature is only necessary and available, 
if spectra acquired with flexControl versions < 2.0 are used!   

2.4.8.4 Delete Segment Spectra 

The Delete Segment Spectra command is active if FAST segments are 
successfully pasted and the pasted spectrum has been saved. The command closes all 
FAST segments and deletes them from the hard drive. This feature corresponds to 
erasing a directory. Applying this command activates message shown in Figure 83.  
Afterwards only the pasted FAST spectrum remains on disk!  

 

Figure 83 Message before erasing the folder 
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2.4.9 View Menu 

 

Figure 84 Contents of the View Menu 

2.4.9.1 Overview 

Table 9  Features of the View Menu 
Feature 
button 

View Menu 
commands 

Shortcut Description 

    

 Auto-Scaling Alt + F9 
Toggles the abscissa and, if possible, the 
ordinate of the active data window between 
auto-scaling and manual scaling. 

 Scale to entire 
Spectrum Ctrl + F9 

All currently displayed spectra are completely 
shown; however auto scaling is not switched 
on. 

 
Horizontal 
Auto-Scaling  Returns from manual horizontal scaling to 

auto scaling. 

 
Vertical Auto-
Scaling  Returns from manual vertical scaling to auto 

scaling. 
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Feature View Menu Shortcut Description 
button commands 

 Set Display 
Range  Sets the data display range for the active 

data window. 

 Zoom F9 Zooms the selected data range. 

 Zoom X Shift + F9 Zooms only in x direction 

 
Undo 
Zooming Alt + Left Undoes the last zooming step.  

 
Redo 
Zooming Alt + Right Redoes the previous unzoom step. 

 Toolbars  Shows, hides, or customizes toolbars. 

 Status Bar  Shows or hides the Status Bar. 

2.4.9.2 Auto-Scaling 

The Auto-Scaling command, the corresponding tool button  and the short cut 
(Alt + F9) are used to toggle abscissa and ordinate in the Mass Spectrum 
Window between auto-scaling and manual scaling.  On selecting this command, the 
auto-scaling mode takes effect or not.  Auto-Scaling means that the display range of 
both axes is automatically adjusted to display the maximum measured values.  When 
this mode is active, the corresponding tool button in the Toolbar is highlighted.   

Note: When using this command in the Mass Spectrum Window, the operator cannot 
individually set the auto-scaling status for the ordinate or abscissa. 

Any changes of the abscissa and/or ordinate display range will deactivate auto-scaling 
of the corresponding axis/axes. 

Auto-scaling can be activated and de-activated with double-click in the display or 
beneath and next to the x- and y-axis. Additionally the button  and  can be used.  

2.4.9.3 Scale to Entire Spectrum 

The Scale to Entire Spectrum command and the short cut (Ctrl + F9) 
are used to return from a zoomed section of a spectrum to the total spectrum. This 
command has the same effect as Auto-Scaling, however the Auto-scale mode is 
not switched on after this command is executed.   

2-74 flexAnalysis 3.0 User Manual, Version 3.0  



Bruker Daltonik GmbH Graphical User Interface (GUI) 

2.4.9.4 Horizontal and Vertical Auto Scaling 

The Horizontal/Vertical Auto-Scaling command and the corresponding 
feature button /  are used to display the entire (mass/intensity) spectrum in the 
Mass Spectrum Window. 

2.4.9.5 Set Display Range 

The Set Display command is used to specify ranges for abscissa and. The Set 
Display Range dialog box opens, which allows setting the mass range and the 
intensity scale when the checkboxes Auto-Scaling are not checked. 

 

Figure 85 Set Display Range dialog box 

2.4.9.6 Zoom 

The Zoom command, the corresponding icon  of the toolbar, and the short cut (F9) 
are used to zoom a section of the display range in the display.  The stack facility is also 
available here, so the operator can toggle between the Undo Zooming and Redo 
Zooming commands.  

The Zoom In function is active after the corresponding tool button is applied.  

Consequently the mouse pointer converts automatically into the Zoom In pointer  
inside the spectrum window.   

The Zoom In function also becomes active when the mouse pointer is inside the 
Mass Spectrum Window and the <Shift>-key is pressed!  
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2.4.9.7 Zoom X 

The Zoom X command, the corresponding icon  of the Toolbar and the short cut 
(Shift + F9) are used to zoom spectra or peaks in x-direction.  The ordinate value 
remains unchanged. 

2.4.9.8 Undo Zooming 

The Undo Zooming command, the corresponding icon  of the Toolbar, the short 
cut (Alt + Left Arrow), and a simple mouse click into the Mass Spectrum 
window (when the Zoom mode is active) are used to reverse the last zooming step that 
was performed. flexAnalysis is able to put the last twenty zooming steps of the current 
session into a particular stack.   

So the operator can toggle back to previous zoom steps by continuously selecting 
Undo Zooming until to the desired display.  When the last step is taken from the 
stack flexAnalysis deactivates this function.   

2.4.9.9 Redo Zooming 

The Redo Zooming command, the corresponding icon  of the Toolbar, or the 
short cut (Alt + Right Arrow) are the counterpart of the Undo Zooming 
function and are used to retrieve a previous step performed with the Undo Zooming 
command.  On selecting Redo Zooming, the display range toggles to the zooming 
step that was performed previously.   

Also here flexAnalysis stacks up to twenty last zooming steps performed during the 
current session.   
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2.4.9.10 Toolbars 

The Toolbars command opens the Toolbars dialog box (Figure 86).  This feature is 
used to show, hide, or customize Toolbars.  This is simply done by (un-)checking the 
corresponding checkbox.  At the same time the related part of the Toolbar appears or 
disappears on the GUI.   

 

 

Figure 86 The Toolbars dialog box 
The list box Toolbars shows all the Toolbars currently defined (defaults as well as 
custom created toolbars). Any toolbar has a check box in front of it indicating its current 
display status.  

The button “New” allows to create a user-defined Toolbar. 

 

Figure 87 New toolbar dialog 
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2.4.9.11 Status Bar 

The Status Bar command is used to show or hide the Status Bar at the bottom of 
the GUI.  When the Status Bar is visible, it is indicated by a highlighted check mark in 
front of this command.   

2.4.10 Tools Menu 

 

Figure 88 Contents of the Tools Menu 
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2.4.10.1 Overview 

Table 10  Features buttons of the Tools Menu  
Feature 
button 

Tools Menu 
commands Shortcut Description 

    

 Report Designer  Opens the ReportDesigner. 

 BioTools  Sends a spectrum to BioTools. 

 PolyTools  Opens PolyTools. 

 ProteinScape  Opens Proteinscape. 

 
Generate 
Molecular 
Formulas 

 Opens the molecular formula dialog. 

 Macro Editor  Opens the macro editor. 

 Customize  Customizes menu bar and toolbar. 

 Options  Customizes the spectrum display. 

 Colors  Coloring specific screen elements. 

 Glycopeptides   

 Send Spectra to 
ProteinScape   Opens the browser to select spectra to send 

to ProteinScape.  

2.4.10.2  
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2.4.10.3 Report Designer 

The ReportDesigner command, and the corresponding icon  of the Toolbar are 
used to start the Bruker Daltonics ReportDesigner, which allows creating own report 
layouts.  Existing layouts can be modified and new ones can be set up. 

To create a new report layout, it is recommended not to modify the original layout but to 
save the modified layout to a new file name. Otherwise, it is possible that your modified 
layout may be overwritten by a later upgrade of the software. 

Use in the ReportDesigner in the File menu the Open command to open and, if 
needed, edit an existing report layout or use the File menu's New command to set up a 
new layout.  

Note: For detailed information to work with the ReportDesigner, refer to the manuals 
on the installation CD.  

 

Figure 89 ReportDesigner with loaded report layout 
Creating a new layout by modifying an existing layout: 

• Click  or from the Tools Menu select ReportDesigner. 
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• From the ReportDesigner's File menu select Open. 

• In the Open dialog navigate to the layout file (*.layout) you want to use as a 
template to create a new layout and click Open.  This loads the selected layout.  

• Modify the layout as desired. 

• From the ReportDesigner's File Menu, select Save As and save the modified 
layout to a new file name. 

• If you don’t want to use the ReportDesigner any longer, select Exit from the 
ReportDesigner's File Menu. 

 

Creating a new layout from scratch: 

• Click  or from the Tools Menu select ReportDesigner. 

• From the ReportDesigner's File Menu select New. 

• Set up the new report as desired. 

• From the ReportDesigner's File Menu select Save As and save the modified 
layout to a new file name. 

• If you do not want to use the ReportDesigner any longer select Exit from the 
ReportDesigner's File Menu. 

The Report Layout files are installed in a folder named Report Layouts, which is 
located in the methods directory (normally D:\Methods\).  

 

2.4.10.4 BioTools 

BioTools is a Bruker program for peak annotation of aminoacids, whose spectra are 
already processed, e.g., with flexAnalysis. BioTools uses these spectra and peaklists 
for DeNovoSequencing on internet searches.  

The BioTools command is active if BioTools is installed (in a compatible version) on 
the same computer and if an analysis is loaded and marked in flexAnalysis.  The 
command is used to save the currently active spectrum, open the BioTools program, 
and transfer the spectrum to BioTools.  
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2.4.10.5 PolyTools 

PolyTools is a program from Bruker for determination of monomers, end groups and 
cations. Spectra must be already processed, e.g., with flexAnalysis since PolyTools 
needs these spectra and peaklists. If isotopes are resolved in the measured spectrum, 
lines belonging to the isotope distribution are identified and can be reduced to amino 
isotopic series.  For every isotope series or the reduced monoisotopic series, the 
average molecular weight, polydispersity, and degree of polymerisation are 
determined.  It is also possible to enter repeat unit, end groups and cation manually, 
either in addition to or replacing the values found automatically. New stick spectra 
calculated from all these data are displayed together with the experimental spectrum 
for comparison (please refer to Bruker’s PolyTools manual PN 205659).  

The PolyTools command is active if PolyTools is installed on the same computer.  
After a spectrum is loaded in flexAnalysis this command is used to open the 
PolyTools program and to transfer the current spectrum.  

 

2.4.10.6 ProteinScape 

ProteinScape is a tool for storing, organizing and analyzing data generated during the 
proteomics workflow.  

The following basic tasks are supported:  

• Data archiving and organization. 

• Data viewing and reporting. 

• In-depth data handling. 

• Data analysis  

ProteinScape is designed as a client-server platform with a simple web browser-based 
user interface. It operates with industry-standard relational database systems like 
Microsoft SQL Server.  

The ProteinScape command is active if the “PSClient” is installed. This has to be 
downloaded from the ProteinScape server. The command ProteinScape is used to 
send spectra to the database ProteinScape. For more detailed information refer to the 
manual that matches to the installed ProteinScape version (1.2 and 1.3). 
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The communication of flexAnalysis with different ProteinScape versions works as 
follows: 

• flexAnalysis 3.0 without psClient: No communication with ProteinScape.  
The command Proteinscape in the Tools Menu is disabled. 

• flexAnalysis 3.0 and psClient 1.2 or psClient 1.3: The communication with 
ProteinScape 1.2 and ProteinScape 1.3 works.  The dialog of psClient is 
available. 

After the command has been executed, the dialog shown in Figure 90 appears. 

 

 
Figure 90 Send to ProteinScape dialog 

Applying the  button in the left upper corner opens the dialog of 
Figure 91, which is described in the Bruker ProteinScape User Manual.   
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Figure 91 Example of an Export to ProteinScape dialog 

Applying the  button opens a window to select a 
spreadsheet/sequence to export the related data files to the ProteinScape server. 

 

 

 

2.4.10.7 Generate Molecular formulas 

The Generate Molecular Formula command is used to calculate all kinds of 
molecular formulas of a measured m/z value taken from a highly resolved mass 
spectrum.  You can preserve (a) pattern(s) of (a) calculated formula(s) by saving 
it/them with the original spectrum as an xml-file. 
The basic result elements of a Generate Formula operation may be displayed in 
HTML format and printed out.  
The calculation of elemental compositions of molecular (and fragment) ions need exact 
mass determinations from a highly resolved mass spectrum.  The aim is to determine 
all theoretically possible elemental compositions of a mass, within a specified error 
tolerance. 
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The higher the measured mass, the more elemental compositions are possible.  For 
example, up to a mass of 1000 Da approximately 66,000 compositions are theoretically 
possible solely consisting of C, H, N and O.  For masses up to 2000 Da this value 
increases up to 520,000.  Additional elements that may be found in the compositions 
will extremely increase the number of compositions. 
Because of this large number of possible combinations it is very time-consuming to 
trace all of them and compare the resulting mass with the measured mass.  Therefore, 
the number of solutions needs to be restricted.  One way is to limit the allowed ranges 
of the occurring atoms.  The problem here is to set the limits in such a way that the 
correct combination will not be excluded.  A better way is to use a more intelligent 
algorithm to confine the number of combinations to be examined.  
flexAnalysis uses an algorithm that is based on the fact that the integer part and the 
fractional part of the molecular mass are linearly independent for organic molecules up 
to a molecular mass of about 1000.  This is used for combining C, H, N and O.  The 
other elements, which usually occur in smaller numbers, are dealt with using the 
straightforward try-and-error method. 
The calculations in generating molecular formulas are based on the isotope masses 
and abundances and the valences given at the Table of Atomic and Isotopic Data we 
use.  The valences used for calculating the rings and double bonds, the electron 
configuration, and the nitrogen rule you can quickly inspect at the Table of Valences, 
too (Please refer to Appendix A-3).   

 
On selecting this command, the Generate Molecular Formula dialog appears (Figure 
92), which allows for entering the m/z value for the possible molecular formulas to 
calculate and defining how the calculation is carried out. 
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Figure 92 Generate Molecular Formula dialog 
Enter all the elements with their allowed minimum (Min) and maximum (Max) atom 
numbers on which the chemical formula calculation is based.  Formula calculation will 
start at the formula entered in Min and stop at the formula entered in Max.  

Tips, how to determine minimum and maximum formulas: 

Generally a CHNO distribution will be calculated.  If you want to exclude one of 
these atoms from the calculation, you explicitly have to set it to ‘0’ (zero).  For 
example, if there should be no N you enter ‘N0’. 

• 

• Sorting of elements is not needed. 

2-86 flexAnalysis 3.0 User Manual, Version 3.0  



Bruker Daltonik GmbH Graphical User Interface (GUI) 

• Brackets can be used to enter fixed atom ratios that should not be resolved.  
For example, when entering ‘[N3P3O6]CHF’ for Min and 
‘[N3P3O6]C100H21F80’ for Max, then calculation will use exactly 3 N, 3 P and 
6 O but 1 to 100 C, 1 to 21 H and 1 to 80 F. 
Chemical notation can be used.  For example, ‘(CH3)6’ will be resolved to 
C6H18. 

• 

(Allowed elements and minimum/maximum atom numbers) 
Lists the constraints to generate molecular formulas as specified in Min and Max, i.e. 
the elements and minimum/maximum atoms numbers allowed.  Within these bounds 
molecular formula calculation will occur. 

Measured m/z: 
Enter the measured m/z value for which possible molecular formulas should be 
calculated.  You can enter this value by typing it in or by selecting it in the currently 
active mass spectrum.  Position the Data pointer at the desired data point and click the 
left mouse button.  This enters the corresponding m/z value. 

Tolerance [ppm]: 
Enter the error tolerance for the mass range to be analyzed in [ppm].  This is a range 
within that flexAnalysis calculates the m/z value of the molecular formulas.  The 
default value depends on the kind of the selected analysis.  For FTMS analyses default 
is ‘2’, for 'ESI-TOF analyses ‘4’ and for all the other analyses ‘50’. 

Charge: 
For multiply charged ions, enter the assumed charge the ion of the Measured m/z 
carries.  Default is ‘1’.  Please consider the sign of the charge.  The mass of the 
electron is not negligible for high mass precision instruments.  Switching between +1 
and -1 makes a difference of two electrons or 1.1 mDa, which means 2 ppm for a 
molecule with 548 Da.  

Automatically locate monoisotopic peak: 
Select this option, if the monoisotopic peak corresponding to the Measured m/z should 
be located automatically.  The algorithm will search to the left and right of the selected 
Measured m/z for appropriate sum formulas with their corresponding monoisotopic 
peaks. 
To use this option select the largest peak of the pattern. 
If the search was successful the found formula(s) for the corresponding monoisotopic 
peak(s) is entered into the results list.   
In formulas containing a monoisotopic peak, which is different from the selected peak, 
the monoisotopic mass is slightly different by a few Da from the selected mass.   
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The mass error nevertheless is calculated for the selected peak and the exact 
theoretical mass of that peak based on the formula from Alan L. Rockwood et al. 
(J.Am.Soc. Mass Spectrom. 2004, 15, 12-21). 
Default is cleared. 

Maximum number of formulas: 
Enter the maximum number of molecular formulas to be calculated at the most.  The 
formulas with the smallest relative error based on the measured m/z will be picked out. 
Default is ‘200’. 

Check rings plus double bonds: 
Select this option if possible molecular formulas should be checked whether the 
number of rings and double bonds present keeps within the bounds specified in 
Minimum and Maximum.  This will exclude all possible formulas with deviating double 
bond equivalence numbers.  Default is not selected.   

The rings plus double bounds number is calculated from the number of atoms and their 
valency: 

2
)2(2 −×Σ+

=+ atomatom valencyndbR  

The valency of C and Si is 4, for N and P a valency of 3 is assumed.  For O and S it is 
2, for H and the halogen atoms it is 1.  For this limited set of atoms the equation 
simplifies to 

1
2
1

2
1

),(),,,,,()( ++−=+ PNIBrClFDHC nnndbR  

All the other elements are also considered.  Double bonds occurring with higher 
valence states like 4 or 6 for sulfur cannot be taken into account as these valence 
states are unknown. 

Minimum: 
Enter the minimum number of rings plus double bonds to be contained in a molecular 
formula at least.  This number may be negative for protonated clusters.  Default is ‘0’. 

Maximum:  
Enter the maximum number of rings plus double bonds to be contained in the 
molecular formula at most.  Default is ‘0’. 

Apply nitrogen rule: 
Check this option, if the nitrogen rule should be applied.  This rule means that, if the 
molecular ion M+ of an organic component has an even molecular weight, it must 
contain an even number of nitrogen atoms.  And if the molecular weight is odd the 
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number of nitrogen molecules must be odd, too.  Things are just the other way if you 
have radical ions. 

Instead of the common definition which considers the production of radical ions by EI 
techniques were are considering the production of pseudo-molecular ions ([M+H]+, 
[M+Na]+, [M-H]-,…) resulting from soft-ionization methods. 

To be more precisely, the number of nitrogen atoms is calculated to be even, if the 
nominal mass plus the number of deuterium atoms plus the charge state is even. 

Applying this rule will result in only formulas complying with the nitrogen rule being 
generated.  Otherwise, also formulas not complying with this rule may be generated.  
Default is unchecked. 

Electron configuration: 
Select the kind of electron configuration to be applied: 

• even. Generates only molecular formulas having an even electron 
configuration.  

• odd. Generates only molecular formulas having an odd electron configuration. 

• both. (Default) Generates molecular formulas of both electron configurations. 

 

The electron configuration is calculated under the assumption that we have molecular 
ions.  The electron configuration is even, if [n(atom) x valency(atom) + z(ion)] is even. 

Minimum C/H ratio: 
Enter the minimum C/H ratio to be applied.  Default in ‘0’. 

Maximum C/H ratio: 
Enter the maximum C/H ratio to be applied.  Default in ‘3’. 

Generate: 
Generates for the mass range that is specified by the Measured m/z and Tolerance 
values molecular formulas that meet the current parameter settings and enters them 
along with corresponding data in the formula list.  

If Show Pattern is already turned on, the pattern of the first formula in this list will be 
displayed below the original spectrum and entered in the Analysis List as a subentry of 
the original spectrum.  

(List of generated molecular formulas): 
Lists the molecular formulas that have been calculated for the specified Measured m/z 
value according to the current parameter settings.  
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For each formula the following set of data is calculated that includes for instance 
various error values, rankings and statistical values:  

#: Consecutive number of the formula. 
MF: Molecular formula. 
m/z: m/z of the formula.  
err [ppm]: Deviation between the measured mass and the theoretical mass of the 

selected peak.  
dbl eq: Number of rings and double bonds in the formula  (refer to page 2-88). 
N rule: Indicates whether the nitrogen rule is fulfilled. 
e-: Indicates whether the electron configuration is even or odd.  The electron 

configuration is calculated under the assumption that we have molecular ions.  
The electron configuration is even, if [n(atom) x valency(atom) + z(ion)] is even. 

 
Various rankings: The ranking is a number between 1 and the number of formulas. ‘1’ 
stands for the best formula candidate according to the individual value.  

rank dIntens: Ranking according to dev Intens. 
rank dIntensVarNorm: Ranking according to dev IntensVarNorm. 
rank dMeanMass: Ranking according to dev MeanMass. 
rank dMass Diffs: Ranking according to dev dMass Diffs. 
rank dCombined: Ranking according to dev Combined. 
rank dMeanMass Error: Ranking according to dev dMeanMass Error. 
rank dm/z: Ranking according to dev m/z. 

 

Various statistical values: 

dev Intens: Root mean square (RMS) of the normalized intensity of the peaks.  
The peaks are normalized so that the sum of intensities is one.  An offset which is 
the same for all peaks is added to reduce an intensity offset which might remain 
after optimizing the digitizer setting. 

dev IntensVarNorm: Same value as dev Intens but the peaks are weighted by the 
square root of the intensity to take into account the ion statistic. 

dev MeanMeas: RMS of intensity weighted mass differences between the 
measured masses and the theoretical masses for the given formula. 

dev MassDiffs: Intensity weighted RMS of the difference between the measured 
and theoretical peak distances between peaks being 1 or 2 Da apart.  Not only 
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the monoisotopic mass and the relative intensities of the peaks depend on the 
formula but also the distances between the various peaks.  With instruments like 
the microTOF and especially the FTMS instruments this difference can be 
measured very precisely even if the absolute calibration might not be optimized. 
This value is especially useful to decide about the number of sulfur atoms.  

dev Combined: This value combines either dev MeanMass or dev m/z (for FTMS) 
with dev IntensVarNorm.  For that purpose each value is normalized by its 
median value calculated for all formula candidates and the sum of the square 
roots is calculated.  This value therefore depends on the set of formulas!  The 
values are weighted in a data dependent way to optimize the selectivity of the 
resulting scoring value. 

dev MeanMass Error: RMS of intensity weighted mass differences between the 
measured masses and the theoretical masses for the given formula.  

 
The formulas are sorted with increasing err [ppm] by default.  Clicking on the column 
header re-arranges the list oppositely.  
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Show Pattern: 

 

Figure 93 Comparing both existing and calculated mass 
The Show Pattern button allows you to compare the pattern of the measured mass and 
the pattern of the selected formula (Figure 93) from the list of calculated masses 
(Figure 92). 

Applying this button adds the pattern of the selected formula into the Mass spectrum 
Window and the formula itself into the Analysis List Window as a subentry of the 
original spectrum.  

Note: flexAnalysis does not save these processes!  This feature is for viewing only, 
however, and may be printed!  
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Save Results: 
Allows you to save the molecular formula results list in a xml-file.  Opens the Save As 
dialog. 

Report:     
The Report button opens a HTML page containing the key-information of the Generate 
Molecular Formulas operation (Figure 94).   
 

 

Figure 94 Example of a report 
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2.4.10.8 Macro Editor 

flexAnalysis offers two different ways for an automatic processing: method scripts and 
macros.  Method scripts and macros are treated differently and designed in different 
editors. The major difference is the range of application.  Method scripts are intended 
to operate on the single analysis they are assigned to, while macros are independent of 
specific analyses  

The Macro Editor command is used to start the flexAnalysis Sax Basic Macro 
Editor (Figure 95). 

 

Figure 95 Sax Basic Macro Editor 
This editor is an interactive design environment for developing, testing, and 
executing Sax Basic macros.  Sax Basic is Visual Basic for Applications™ 
compatible.   

• 

• 

• 

flexAnalysis macros have a reference to Bruker flexAnalysis 3.0 Type 
Libraries, which makes all flexAnalysis scripting objects available.   
Please refer to the editor help from the Help Menu in the flexAnalysis Macro 
Editor for a detailed description on how to open, to create, and to execute 
macros within the macro editor.   
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2.4.10.9 Customize 

The Customize command is used to vary the contents of the menu bar.  Additionally 
the user can remove or add parts of the toolbar.  These features are available on the 
tabs Toolbars and Command of the dialog Customize.   

 

Figure 96 Toolbars tab (displayed by default) 
After opening, this dialog shows first the Toolbars tab, which provides default palettes 
that contain feature buttons to be temporarily removed or docked on to the GUI by 
applying the corresponding checkbox (there is no access to the checkbox Menu Bar).  
The button “New” opens the New Toolbar dialog in order to specify a name for the new 
empty palette that will appear at once on the Graphical User Interface after closing with 
the “OK” button.   

 

Figure 97 Creating a new Toolbar name 
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The symbols of the Command tab (Figure 98) may be used to add one or more 
functions to the new palette.  For instance, the user wants to add the Delete symbol 

. To do so, switch to the Command tab, open the category Edit and transport the 
Delete symbol with the drag and drop to the new palette.   

 

Figure 98 The Commands tab 
The operator must be aware that in contrast to new palettes created by him, the 
defaults can only be removed from the GUI but not deleted out of the program.  On 
choosing a user created palette the “Reset” button toggles to “Delete”.  
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2.4.10.10 Options 

The Options command and the corresponding icon  of the Toolbar are used to 
manipulate optional settings for flexAnalysis.   

The related dialog (Figure 99) consists of four tabs, Display, Labels, Export, and 
Calibration.   

 

Figure 99 Option to specify the spectrum display 

2.4.10.10.1 Display 
The group box ‘Stacked’ contains the parameter Angle to arrange spectra in a specific 
angular position in the display whereas the parameter Offset specifies the distance 
among the shown spectra. These parameters determine how spectra appear in the 
Stacked View of the display.The parameter Windows of the group box ‘List’ 
determines the number of windows displayed in the List View.  

2.4.10.10.2 Labels 

 

Figure 100 Option to specify the appearance of the peak annotation 
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The Label tab (Figure 100) contains two groups of radio buttons to specify how peak 
labeling shall be performed.    

 

Density:  

• Non-overlapping – prevents overlapping of the labels with the spectrum curve.  
Labels are not shown, if they would overlap with the spectrum or neighbouring 
labels.  

• Non-overlapping with tics – prevents overlapping of the labels and shows tics 
on the top of a labeled peak. 

• Overlapping – overlaps the peak labels. All labels of all peaks of the mass list 
are shown.   

• Tics only – shows only tics on the top of detected peaks. 

Orientation:  

• Horizontal – displays the labels of the m/z values horizontally. 

• Vertical – displays the labels of the m/z values vertically. 

2.4.10.10.3 Export 

 

Figure 101 Option to specify the numerical precision of the coordinates 
The Export feature allows the operator to adjust the numerical precision of the x (mass) 
and y (intensity) value. Choose these values as small as possible in order to save disk 
space and processing time. The values chosen here are the number of digits used for 
each data-point when exporting a mass spectrum. You can define with which resolution 
your graphics are exported by adjusting the DPI value. 
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2.4.10.10.4 Calibration 
 

 

Figure 102 Option to specify the tolerance of the calibration strategy 
Settings on this tab are relevant for internal recalibration (section 2.4.5.2). The Near 
Neighbor tolerance applies to the Interactive calibration, whereas Default Calibrant is 
used for Statistical Peptide. 

Also the global use of High Precision Calibration (HPC) can be activated in this dialog.  
HPC is a fine correction of the calibration in the mass range between 700 and 4000 Da 
(refer to section A-2 for details).   
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2.4.10.11 Colors 

The Colors command is used to assign colors to particular screen elements in the 
Mass Spectrum Window. Several Screen Elements are offered. Newly added in this 
flexAnalysis version are Background Peak Label and Annotation label. 

If peaks are recognized as backgrounds (Identify Backgrounds Macro) but not 
yet deleted from the peaklist they will be shown colored with the color selected here. 
The annotations added via the new Annotation tool are also displayed in the color 
selected in this dialog. 

  

Figure 103 Colors dialog box 

2.4.10.12 Glycopeptides 

For detailed information, please have a look in the tutorial 
"Quickstart_GlycopeptidesFA3.0.pdf".  

2.4.10.13 Send Spectra to ProteinScape 

The Send Spectra to ProteinScape macro is used to send data to your 
ProteinScape server.  Applying this command opens the Spectrum Browser to select 
and load data.  

2-100 flexAnalysis 3.0 User Manual, Version 3.0  



Bruker Daltonik GmbH Graphical User Interface (GUI) 

2.4.11 Window Menu 

 

Figure 104 Contents of the Window Menu 

2.4.11.1 Overview 

Table 11  Features of the Window Menu  
Feature 
button 

Window Menu 
commands 

Shortcut Description 

    

 Analysis List Alt +1 Fades in/out the Analysis List Window. 

 Mass Spectrum Alt +2 Fades in/out the Mass Spectrum Window. 

 Mass List Alt +3 Fades in/out the Mass List Window. 

 Sequence List  Fades in/out the Sequence List Window 

 

2.4.11.2 Analysis List 

The Analysis List command, the corresponding icon of the toolbar , and the 
short cut (Alt + 1) display or remove the analysis list from the GUI. On displaying 
the list a highlighted check mark is shown in front of this command.   

2.4.11.3 Mass Spectrum 

The Mass Spectrum command, the corresponding icon of the toolbar , or the 
short cut (Alt + 2) toggle the Mass Spectrum Window and the Bruker symbol.  On 
displaying the spectrum a highlighted check mark is shown in front of this command.   
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2.4.11.4 Mass List 

The Mass List command, the corresponding icon of the toolbar , and the short 
cut (Alt + 3) display or hide the mass list from the GUI. When the Mass List 
Window is shown, the tool button shown in front of this command is highlighted. 

2.4.11.5 Sequence List 

The Sequence List command, the corresponding icon of the Toolbar  and the 
shortcut (Alt + 4) fill this window with sequence tags, which you can create with the 
annotation feature (section 2.4.6). If there is a gap in the sequence tag, a new entry 
with the next abbreviation of the currently chosen annotation will occur in this window. 
You can save this sequence list together with the spectrum. If you save and close a 
spectrum and re-open it afterwards, the same sequence list can be seen again. 
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2.4.12 Compass Menu 

 

Figure 105 Content of the Compass menu 

2.4.12.1 Overview 

Table 12  Features of the Compass Menu 
Feature 
button 

Compass Menu 
commands 

Shortcut Description 

    

 License  Enter the License number here. 

 Operator  Changes the operator. 

 Lock all Applications Ctrl + Alt + K Locks all programs in case the 
Compass Security Pack is installed. 

 Compass Desktop F11 Opens the Compass Desktop. 

 FlexControl Ctrl + F11 Opens flexControl. 

 BioTools Alt + F12 Opens BioTools. 

 Audit Trail Viewer  
Opens the Audit Train Viewer in 
case the Compass Security Pack is 
installed. 

2.4.12.2 License 

The License command is used to open the Bruker Daltonics LicenseManager dialog 
box for viewing or adding/removing licenses for Bruker products. The License Manager 
looks the same in nearly all programs. It is not necessary to enter a license for a 
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special Bruker program in the respective program; it can be entered via the License 
Manager of other Bruker programs. 

 

Figure 106 The License Manager 

2.4.12.3 Operator  

The Operator command is used to log on as new operator. The new operator name 
appears in the Status bar at the bottom of the GUI. In case the Bruker Daltonics 
UserManagement is installed additionally a password is requested.  

If a user logs on with the Operator command the user automatically changes for all 
other Bruker programs that are currently open and run with the UserManagement. In 
flexControl this can be seen because the Select Method dialog comes up.  

2.4.12.4 Lock all applications 

The Lock all Applications command and the short cut (Ctrl + Alt + K) 
lock all the Bruker applications that are currently open depending on the lock-time that 
is defined in the UserManagement. Additionally the Unlock dialog opens. 

If one program is locked (manually or via timeout), all programs that run with the 
UserManagement are locked, since they all use the same UserManagement server. In 
this case it is necessary to un-lock only one program. A locked program can only be 
un-locked from the user who locked it, or from the UserManagement administrator. 

The command is only available in case of an installed Bruker Daltonics 
UserManagement.    
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2.4.12.5 Compass Desktop  

The Compass Desktop command opens the so called Bruker Compass. This GUI 
offers access to the installed Bruker programs distributed in Acquisition, Processing, 
Data Interpretation, and the belonging manuals.  

 

Figure 107 Compass Desktop GUI 

2.4.12.6 FlexControl 

The FlexControl command is used to open flexControl or bring it to front if it is 
already open. Data transfer cannot be achieved with this command (or with any other). 

2.4.12.7 BioTools 

The BioTools command is used to open BioTools or bring it to front if it is already 
open. Data transfer cannot be achieved with this command, i.e. no spectrum is sent to 
BioTools. To send spectra use the BioTools command from the Tools menu (section 
2.4.10.4). 
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2.4.12.8 Audit Trail Viewer 

The Audit Trail Viewer command opens the Bruker Daltonics AuditTrailViewer 
dialog. It is only available if the Bruker Usermanagement is installed. 

 

Figure 108 Audit Trail Viewer 
 

 

2.4.13 Help Menu 

 

Figure 109 Contents of the Help Menu 
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2.4.13.1 Overview 

Table 13  Features of the Help Menu 
Feature 
button 

Help Menu commands Shortcut Description 

    

 Help Topics F1 Opens the help file. 

 
About Bruker Daltonics 
flexAnalysis 3.0  Opens the About Window 

2.4.13.2 Help Topics 

The Help Topics command, the corresponding icon  of the Toolbar, and the 
short cut (F1) open the flexAnalysis online-help to get information about specific 
topics.   

2.4.13.3 About Bruker Daltonics flexAnalysis 

This command opens the About dialog (Figure 110) that displays the version number 
of your flexAnalysis version with the copyright notice, the user-specific license 
information, and contact information of Bruker Daltonik GmbH. 
 

 

Figure 110 About dialog 
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2.5 Analysis List Window 

The Analysis List Window (or treeview) is used to display one or more selected 
analyses and their related spectra.   

 

 

 

2.6 Mass Spectrum Window 

The Mass Spectrum Window (or display) is used to display a spectrum or spectra of 
one or more analyses prior selected in the Analysis List Window.   

When a spectrum is displayed and the mouse pointer is within these window 
boundaries two interactive modes for convenient handling are available. 

Mouse pointer + the <Ctrl> key →    Edit mode (section 2.4.3.3). 

Mouse pointer + the <Shift> key →  Zoom mode (section 2.4.9.7).   

flexAnalysis allows to toggle between both modes by alternately pressing the two 
keys (the mouse must be in the Mass Spectrum Window).   

 

 

 

2.7 Mass List Window 

The Mass List Window (or peaklist) is used to display masses and peak parameters 
of a prior selected spectrum in the Mass Spectrum Window or the Analysis List 
Window.  Only one mass list is displayed at a time. This list layout can be customized 
(section 2.4.7.6.4).    
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2.8 Context Sensitive Menus 

2.8.1 Getting Context Menus 

flexAnalysis offers three context menus accessible with the right mouse click.  
Depending on the window of the GUI, Treeview, Display, or Peaklist, the 
corresponding menus shown in Figure 111 appear.  The content of the respective 
menu is a summery of specific commands and complies with the feasible handling of 
the window’s content.   

2.8.2 Context Menus of the three flexAnalysis Windows 

 

 

 
 

 

Figure 111 Context menus of the Treeview, Display and Peaklist window 
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All features (except of Add to MS/MS List, Show/Show always, hide Y-
axis and Axis Font…) of the context menus are also available via buttons or one 
of the main menus. Detailed information on the features is given in the respective 
section.  For information on Add to MS/MS have a look in section 2.4.3.6. 
 
 

2.9 Pointers and Interactive Modes 

To facilitate operating with flexAnalysis different pointers are provided, anyone 
associated with a specific function.   

Data pointer: 

 
The data pointer accompanies vis-à-vis the arrow pointer of the mouse within the Mass 
Spectrum Window.  In the case of two or more spectra the data pointer resides on the 
last generated spectrum.  The m/z value and the related intensity of the current position 
of the data pointer are displayed in the Status Bar of the Graphical User Interface at 
the right.   

Pointers for direct manipulation: 

Horizontal Window Border pointer: 

 (docked windows)         (undocked windows) 

This pointer is used to change the height of a window.  It is displayed when the mouse 
pointer is positioned on the upper or lower border of a window. 

 

Vertical Window Border pointer: 

(docked windows)      (undocked windows) 

This pointer is used to change the width of a window.  It is displayed when the mouse 
pointer is positioned on the left or right border of a window. 

 

Horizontal Scaling pointer: 

 
This pointer appears below the abscissa of the Mass Spectrum Window.  

It is used to shift the spectrum and the scale horizontally.   
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Vertical Scaling pointer: 

 
This pointer appears below the ordinate of the Mass Spectrum Window.  It is used to 
shift the spectrum and the scale vertically.   

 

Column Width pointer: 

 
This pointer is used to change the width of columns, such as those in the Mass List 
Window.  It is displayed when the mouse pointer is positioned on the left or right 
border of a column head. 

Pick pointer: 

 
This pointer is used to directly select a mass spectrum in the Mass Spectrum 
Window.  It is displayed when the mouse pointer is positioned near a data point (3 
pixel) of a currently unselected mass spectrum. 

 

Interaction Mode Mouse pointers: 

Zoom In pointer: 

 
This pointer is used to zoom the display range of a data window.  It is displayed when 
the Zoom In mode is active and when the mouse pointer is positioned on a data 
window's display.   

Access: Mouse pointer + <Shift> key => Zoom mode (please refer to section 2.4.9.6). 
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Edit Mass List pointers: 

     
These pointers are used to add a peak or to delete a peak from the Mass List in a 
spectrum displayed in the Mass Spectrum Window.  They are displayed in addition to 
the Data pointer, when the Edit Mass List mode is active and the mouse pointer is 
positioned on the selected spectrum.   

Which of both pointers is displayed at a time depends on the actual position of the Data 
pointer.  

   The Delete pointer appears when the Data pointer is positioned on a data point 
that belongs to a mass peak already present in the spectrum's mass list. 

   The Add pointer appears when the Data pointer is positioned on a data point 
when its mass peak is not yet present in the Mass List window.   

Access: Mouse pointer + <Ctrl> key => Edit mode (please refer to section 2.4.3.3).   

 

Internal Calibration pointer: 

 
This pointer is used to calibrate internally the mass spectra of an analysis.  It is used to 
manually select a peak from a mass spectrum displayed in the Mass Spectrum 
Window and to assign it to a selected reference mass.  It is displayed in addition to the 
Data pointer when the Internal command from the Tools menu is active and the 
mouse pointer is positioned on the selected mass spectrum. 
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A Appendix 

A-1 Calibration Procedures 

The following paragraphs summarize the three different recalibration procedures. 

A-1.1 HOW TO CALIBRATE INTERNALLY USING THE STATISTICAL PEPTIDE 
CALIBRATION:  

1. Select exactly one spectrum in the Analysis List Window.  Make sure that this 
spectrum is displayed in the Mass List Window.  

2. Open the Internal Mass Spectrum Calibration dialog and select “Statistical 
peptide”, if this option is not already selected. 

3. See Golden Rules on page 2-42. 

4. Press the “Calibrate” button. 

5. If satisfied with the new calibration press “OK”. 

 

A-1.2 HOW TO CALIBRATE INTERNALLY USING THE AUTOMATIC 
ASSIGNMENT PROCEDURE:  

1. Select exactly one spectrum in the Analysis List Window.  Make sure that this 
spectrum is displayed in the Mass List Window. 

2. Open the Internal Mass Spectrum Calibration dialog and select “Interactive” 
and choose a reference list containing the masses of your calibrants in the 
spectrum. 

3. Make sure that the settings for quadratic calibration, mass tolerance and 
calibration list are feasible for your spectrum.    

4. Press the “Automatic Assign” button.  flexAnalysis 3.0 performs an assignment 
of calibrant masses and recalculates the calibration (c0 – c2) using this new 
assignment.  The line of assigned masses (reference mass and mass of the 
spectrum) is marked with a check in the calibrant list.  Additionally the error 
between both masses is displayed in ppm or in Da.   
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A-1.3 HOW TO CALIBRATE INTERNALLY USING THE INTERACTIVE 
ASSIGNMENT PROCEDURE: 

1. Select exactly one spectrum in the Analysis List Window.  Make sure that this 
spectrum is displayed in the Mass List Window. 

2. Open the Internal Mass Spectrum Calibration dialog and select “Interactive” 
and choose a reference list containing the masses of your calibrants in the 
spectrum. 

3. Make sure that the setting for the zoom range fits to the quality of the current 
spectrum calibration and that the open calibration list is the correct one. 

4. Select the row of your calibrant in the reference mass list with a mouse click on 
that row.  The row is now marked with a red arrow indicating that the calibrant is 
in use, but not assigned.  If you have chosen a correct setting for your zoom 
range your calibrant peak is displayed in the Mass Spectrum Window.   

5. Select your calibrant peak in the Mass Spectrum Window with a mouse click 
on the top of the peak.  If the assignment was successful the current mass entry 
and the error entry are filled with the calculated values.  The row is now marked 
with a green arrow that indicates a successful assignment.  The calibration 
constants displayed in the dialog (c0 – c2) are also immediately updated.   

6. Whether the calculation based on the new assignment improved the calibration 
can be evaluated by checking the standard deviation values before and after 
calibration.  The calibration constants itself can be checked by pressing the 
“Check Calibration” button. 

7. Repeat steps 4 and 5 by using the mouse wheel until you have either assigned 
all the entries in your reference mass list or all the calibrant peaks in your 
spectrum.   

When the user wants to remove a calibration point from the table he simply clicks with 
the left mouse button onto the corresponding line.  Be aware that the button “Clear” 
removes all the previously matched masses!  

The user can also verify whether a spectrum is calibrated correctly within the properties 
dialog. 
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A-2 High Precision Polynomal Calibration (HPC)  

A-2.1 WHAT IS HPC?  

HPC is a fine correction of the calibration in the mass range between 700 and 4000 Da 
available on ultraflex mass spectrometers.   

The use of any kind of pulsed ion extraction in time of flight mass spectrometry distorts 
the linear relationship between m/z and the square of the ion flight time.  By empirically 
fitting the residual deviation (few ppm) from the ideal quadratic calibration by a high 
order polynomial (HPC) one can significantly increase mass accuracy, esp. for masses 
below 1kDa.  For details please refer to Gobom J. et al., Anal. Chem. 2002, 74, 3915-
3923. 

 

A-2.2 HOW CAN I USE HPC ON THE ULTRAFLEX? 

ultraflex instruments (production 4/03 or later) are equipped with a dedicated HPC 
flexControl acquisition method called “Proteomics_HPC.par”.  This method preset at 
the factory contains all relevant HPC parameters and must not be changed.  If you 
change any of the instrument voltages or the deflection pulser settings the HPC 
method becomes invalid!  

Use “Proteomics_HPC.par” for all standard proteomics applications and the HPC 
correction is automatically performed in flexControl2.x and flexAnalysis2.x without 
any user interaction for all spectra acquired with this method (provided that HPC is not 
globally switched off in flexAnalysis.  Use the common calibration and mass list 
generation procedures for those spectra.  

Note:  HPC does only eliminate the deviations from the quadratic calibration function, 
and it does not replace a good quadratic calibration! 
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A-2.3 CAN I GENERATE MY OWN HPC METHODS WITH DIFFERENT 
INSTRUMENT SETTINGS? 

No, HPC setup can only be done in the factory. 

 

 

A-2.4 HOW CAN I CHECK HPC PERFORMANCE? 

Acquire mass spectra of samples with about 10 known peaks in the mass range 750-
3500Da using the HPC method “Proteomics_HPC.par”.  The most relevant HPC 
correction takes place below 1kDa, therefore it is essential that the sample contains 
calibrants between 750 and 1000Da.  We recommend to use the Bruker 
PeptideCalibration standard and to add Bradykinin (fragment 1-7, 757 Da) in order to 
cover the low mass range.  
Perform internal quadratic calibrations with flexAnalysis using the known 10 peaks as 
calibrants.  If HPC is switched on (check box in flexAnalysis) mean mass errors of 
about 3-5ppm are typically achieved, whereas results are significantly worse (about 
10ppm) with deactivated HPC.      
 

 

A-2.5 CAN I USE HPC ON AN AUTOFLEX? 

There is no need for HPC on autoflex, because these instruments already have an 
almost perfect quadratic calibration curve. 
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A-3 Table of Valences 

The valency of the atoms, which are used for the calculation of the ring and double 
bonds, the electron configuration and the nitrogen rule when using the Generate 
Formula command from the Tools Menu are as follows (the atoms are ordered with 
increasing atomic number/atomic weight).  
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Atom Valency Atom Valency Atom Valency Atom Valency 

H  1 Ni  2 La  3 Rn  0 
D  1 Cu  1 Ce  4 Fr  1 
T  1 Zn  2 Pr  3 Ra  2 
He  0 Ga  3 Nd  3 Ac  3 
Li  1 Ge  4 Pm  3 Th  4 
Be  2 As  3 Sm  2 Pa  4 
B  3 Se  2 Eu  2 U  3 
C  4 Br  1 Gd  3 Np  3 
N  3 Kr  0 Tb  3 Pu  3 
O  2 Rb  1 Dy  3 Am  3 
F  1 Sr  2 Ho  3 Cm  3 
Ne  0 Y  3 Er  3 Bk  3 
Na  1 Zr  4 Tm  3 Cf  3 
Mg  2 Nb  5 Yb  2 Es  3 
Al  3 Mo  6 Lu  3 Fm  3 
Si  4 Tc  4 Hf  4 Md  3 
P  3 Ru  3 Ta  5 No  2 
S  2 Rh  3 W  6 Lr  3 
Cl  1 Pd  2 Re  4 Rf  0 
Ar  0 Ag  1 Os  3 Db  0 
K  1 Cd  2 Ir  3 Sg  0 
Ca  2 In  3 Pt  2 Bh  0 
Sc  3 Sn  4 Au  1 Hs  0 
Ti  4 Sb  5 Hg  2 Mt  0 
V  5 Te  2 Tl  3 Ds  0 
Cr  3 I  1 Pb  4 Uuu  0 
Mn  2 Xe  0 Bi  5 Uub  0 
Fe  2 Cs  1 Po  2 Uuq  0 
Co  2 Ba  2 At  1 Uuh  0 

 

Table of Valences 
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Edit Building Blocks command (Annotation 
menu) 2-48 

About Command 2-107 
Analysis List command 2-101 
Analysis Window 2-108 
Assistance viii, 2-107 

Edit command 2-24 
Edit Parameters command 2-53 
Edit Script command 2-67 Auto-Scaling command 2-74 
Exit command 2-16 B Export command 2-11 

Batch Process command 2-33 F BioTools command 2-81 
Files for recalibration 2-7 Box Selection command 2-22 
Filter Background Peaks command 2-27, 2-

29 C 

Find command 2-23 Change Parameters command 2-71 
Clear command 2-24, 2-25 H Clear Range Selection command 2-22 

Help Topics command 2-107 Close command 2-8 
High Precision Calibration 2-99, A-III Color command 2-21 
Horizontal Auto-Scaling command 2-75 Colors command 2-100 

Compass Security Pack 1-1 
Contents iii I 
Copy Calibration command 2-42, 2-43 Installation 1-4 
Copy command 2-18 Interactive modes 2-108 
Customize command 2-95 Internal Calibrate command 2-36 

Internal calibration procedure A-I D 
L Default Color command 2-21 

Delete command 2-19 License command 2-104, 2-105 
Delete Segment Spectra command 2-72 Lock all Applications command 2-104 
Distance in Masses command 2-29 
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M 

Macro Editor command 2-94 
Mass List command 2-102 
Mass List Window 2-108 
Mass Spectrum Command 2-101 
Mass Spectrum Window 2-108 
Menu Bar 2-3 
Microsoft .NET Framework 1-1 

O 

Open command 2-50 
Operator command 2-104 
Options command 2-97 

P 

Paste Segment Spectra command 2-70 
Paste Special command 2-19 
PolyTools command 2-82 
Print Preview command 2-13 
Process Spectra command 2-34 
ProteinScape command 2-82 
Purpose of the software 1-1 

R 

Range Selection command 2-21 
Redo Zooming command 2-76 
Report Designer command 2-80 
Rules for statistical calibration 2-42 
Run Script command 2-52 

S 

Save All command 2-9 
Save As command 2-9, 2-52 
Save command 2-52 
Scale to Entire Spectrum command 2-74 
Select All command 2-20 
Select Default command 2-68 
Select None command 2-20 
Set Display Range command 2-75 
Smooth Mass spectrum command 2-32 
Statistical peptide calibration procedure A-I 
Statusbar 2-3 
Statusbar command 2-78 
Subtract Mass Spectrum Baseline 

command 2-32 

T 

Title bar 2-2 
Toolbar 2-3 
Toolbars command 2-77 
tools menu 2-35 

U 

Undo All Processing command 2-32 
Undo Zooming command 2-76 
User management 1-1 

V 

View Analysis command 2-20 
View Spectrum command 2-20 

W 

Window menu 2-101 

Z 

Zoom command 2-75 
Zoom X command 2-76 
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